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1 Disclaimer
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USER MANUAL
The information in this document is subject to change without notice, while every effort is made to be
accurate. Analog Way cannot be held liable for any kind of loss whatsoever
thatMANUAL
may be caused by the use of
USER
or reliance in this manual.
USER MANUAL

1.1 Copyrights
USER MANUAL
The Software installed in the Picturall Series Media Server remains the sole property of Analog Way unless
stated otherwise in a separate licensing agreement. Any attempt to copyUSER
or alter
the software is prohibited
MANUAL
and will render any warranties void.
USER MANUAL

1.2 Media
Analog Way may have supplied video libraries pre-installed on the media server. If you have any questions
regarding them, please contact us. These videos have been licensed exclusively for use within the Picturall
Series Media Servers. Any copying or other usage without proper rights clearance is forbidden. Analog Way
will not accept any liability or claims from third parties.

1.3 Warranty
The Picturall Series Media Server has been tested in various applications and is deemed to be suitable for
uses described in this manual. This product is provided “as is”, including all or any ‘perceived’ or possible
faults. The Licensor grants no warranty regarding the utility or contents of the software. Analog Way will
warrant the hardware for three years from the date of purchase. The method of warranty is Return to Base
(transport costs from and to us are the owner’s responsibility). In case of hardware fault please contact your
local distributor or us (www.analogway.com).
While not an exhaustive list, the following are provided for guidance. Warranty claims will be invalidated in
these circumstances:
•

•
•

A hardware failure is caused by inappropriate handling of hardware such as dropping the media
server, using the media server without proper ventilation, exposing the media server to water, other
liquids or dust.
The software has been loaded or there has been an attempt to load software onto the media server
in any way other than described in the manual or recommended by Analog Way.
The hardware has been modified by someone other than a certified Analog Way dealer.

1.4 Liability
Analog Way shall not be liable for any loss or damage, be it direct or indirect in regards to the utility or
contents of the software or hardware, except to the extent provided by law. Notwithstanding the above,
liability for indirect, special, incidental or consequential loss or damage that may arise in respect of the
software or hardware, is expressly excluded.

1.5 Force Majeure
Liability of Analog Way is excluded in all cases that constitute Force Majeure circumstances, namely,
circumstances beyond the control of Analog Way.
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2 Introducing Picturall Series Media
Servers
USER MANUAL
Thank you for choosing Picturall Series Media Servers! The one that combines cutting-edge technology with
ease-of-use and unrivalled efficiency.
USER MANUAL
Picturall Series Media Servers are powerful real time multi-output media servers. They can manage multiple
inputs (media files, live feeds or network streams) with various featuresUSER
and effects.
Then output them to
MANUAL
multiple displays.
USERexclusively
MANUAL for Picturall Series
Control the server with Picturall Commander, a dedicated software designed
Media Servers. Alternatively, Picturall Series Media Servers can also be controlled with External controllers
USER MANUAL
such as Lighting consoles.
USER MANUAL
Picturall Series Media Servers are 19” wide and 4 rack units (4U) high, following the industrial rack mounting
standard. The Twin and Quad are also available in Compact versions (2U) with the same number of outputs
and the same efficiency as their 4U counterparts.

2.1 Picturall Series Media Servers
The Picturall Series Media Servers product range includes 3 models: Twin, Quad, and Pro.
The following table illustrates the differences between the units.
Picturall Series
Media Servers

Outputs

Twin &
Twin Compact

2

Quad &
Quad Compact

4

Pro

Up to 16

Description
Heavy-duty dual-output 4K Series Media Server. Designed for mediumsized events and installations requiring high levels of performance and
reliability.
Heavy-duty quad-output 4K Series Media Server. Designed for large scale
events and installations requiring high levels of performance and
stability.
Mission critical 8K modular Series Media Server. Engineered to support
massive events and installations from one single server unit.

Table 1 - Picturall Series Media Servers family

2.2 Package Contents
The Picturall Series Media Server sales package includes:
-

One Picturall Series Media Server
One Power cord
One Rackmount kit
One Ethernet cross cable
One USB memory stick containing the Picturall Commander and server software

A USB keyboard is needed for configuring the server and a remote computer for running Picturall
Commander.
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2.3 Front panel

USER
MANUAL
All the Media Servers have the same front panel. It is composed of one OLED
display,
two USB ports, a Power
button and a Next/Status button.
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
Fig. 1 - Front panel

2.3.1 Display screen
The front panel displays information such as device IP address, firmware version, or CPU.
-

Press the Next/Status button to wake the display and show server information.
Press again to cycle through the next pages.

The display automatically goes off after 3 minutes of inactivity.

2.3.2 Power off
Tip: The following procedure is the recommended method to safely turn off the Media Server.

To turn off the media server, press the Power button then press the Next/Status button to confirm.

2.3.3 Forced shutdown
If the Media Server crashed, turn off the power by Forced shutdown.
-

Press and hold the Power button until shutdown.

Caution: Using Forced shutdown regularly is not recommended. Use Forced shutdown only if the Media Server has
crashed.

2.4 Rear panels and Connections
The Media Server chassis and the hardware are designed to produce the best possible performance in a sleek,
rack-mountable unit.
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2.4.1 Picturall Twin rear panel

USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL

Fig. 2 - Picturall Twin rear panel
1.
2.
3.
4.
5.
6.
7.

Power supply (optional redundant and hot-swappable power supplies)
Two-channel audio interface with balanced XLR outputs (optional)
RS232 plug (optional)
Ethernet plug
USB plug
Two DisplayPort 1.2 outputs (4K@60Hz 10-bit 4:4:4)
Two slots for additional input cards

2.4.2 Picturall Twin Compact rear panel

Fig. 3 - Picturall Twin Compact rear panel
1.
2.
3.
4.
5.
6.
7.

Power supply
RS232 plug (optional)
Two-channel audio interface with balanced XLR outputs (optional)
USB plug
Ethernet plug
Two DisplayPort 1.2 outputs (4K@60Hz 10-bit 4:4:4)
One slot for additional input card
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2.4.3 Picturall Quad rear panel

USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL

Fig. 4 - Picturall Quad rear panel
1.
2.
3.
4.
5.
6.
7.

Power supply (optional redundant and hot-swappable power supplies)
Two-channel audio interface with balanced XLR outputs (optional)
RS232 plug (optional)
Ethernet plug
USB plug
Four DisplayPort 1.2 outputs (4K@60Hz 10-bit 4:4:4)
Two slots for additional input cards

2.4.4 Picturall Quad Compact rear panel

Fig. 5 - Picturall Quad Compact rear panel
1.
2.
3.
4.
5.
6.
7.

Power supply
RS232 plug (optional)
Two-channel audio interface with balanced XLR outputs (optional)
USB plug
Ethernet plug
Four DisplayPort 1.2 outputs (4K@60Hz 10-bit 4:4:4)
One slot for additional input card
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2.4.5 Picturall Pro rear panel

USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL

Fig. 6 - Picturall Pro rear panel
1.
2.
3.
4.
5.
6.
7.
8.
9.

USER MANUAL

Power supply (optional redundant and hot-swappable power supplies)
Two-channel audio interface with balanced XLR outputs (optional)
RS232 plug (optional)
Primary Ethernet plug (left), secondary Ethernet plug (right)
Two USB plugs
Four DisplayPort 1.2 outputs (4K@60Hz 10-bit 4:4:4)
Three slots for additional output cards or input cards
One slot for additional input card only
One slot for optional sync card
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2.4.6 Optional Hardware

The Picturall Series Media Servers can be equipped with various options. USER MANUAL
Option

DescriptionUSER MANUAL

Dual Power supply unit
Audio XLR output
SSD storage device
Performance and
Performance+ SSD*
Output card
Input cards

Redundant, hot-swappable power supplies
USER MANUAL
Two-channel audio interface with balanced XLR outputs
Replaces the default SSD for more storage
USER MANUAL
Replaces the default SSD for more storage and enhanced performance
USER MANUAL
4 x DisplayPort 1.2
USER MANUAL
2 x HDMI 1.4
4 x HDMI 1.4
1 x HDMI 2.0
2 x HDMI 2.0*
2 x 3G-SDI
4 x 3G-SDI
1 x DVI
2 x DVI

Sync card*

Add Genlock feature to the Media Server

10GB Network card**

Add a 10GB RJ45 port to the Media Server

*option available for Picturall Pro only
**option available for Picturall Twin, Quad and Pro

Table 2 - Picturall Series Media Servers optional hardware
For more information on optional hardware, visit www.analogway.com or contact Analog Way support.
For more information on the Sync card, see 10.2 Sync card – Genlock (Picturall Pro only) page 73.

2.4.7 External Audio support (optional)
Caution: Disconnecting the sound card may freeze all layers with audio playback.

The Picturall Series Media Servers support various audio interfaces.
Audio support lets the media server adjust audio settings for medias files with embedded audio.
For more information, see document Picturall Servers Audio Options available on www.analogway.com or
contact your reseller or Analog Way support.
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3 Getting Started

USER MANUAL
USER MANUAL

3.1 Precautions when Mounting Picturall Series Media Server

USER MANUAL

Caution: Follow these precautions to avoid risks for products and users.

USERpoints
MANUAL
When mounting the server, ensure proper air flow and consider the following
on safe use.
-

-

Always use the handles built on the sides of the chassis for easy mounting into any standard rack or
USER MANUAL
flight case.
Remove the front and back panels of the flight case during operation
to provide sufficient air flow
USER MANUAL
through the unit and prevent overheating.
Place the server preferably in a cool and dry environment.
USER MANUAL
The fans inside the server expel the heat through the front and rear panels. Therefore, it is crucial
that both the front and the rear are unobstructed at all times. A minimum of 50 cm (20 in.) of clear
space at the front and rear of the unit is recommended.
Do not block the ventilation.
Do not place any fluid above or near the server.
Do not apply any pressure against the chassis or the connectors.

3.2 Start the Picturall Series Media Server
When starting the media server for the first time, a test image with server IP address and display number is
sent to every connected display. This helps identifying displays and checking the setup is correct.
Tip: Connect all displays before starting the media server for the first time.

To start the Picturall Series Media Server safely and correctly:
1.
2.
3.
4.

Connect the power cable to the server and then plug it into a mains socket.
Connect displays to the media server (at least one display to the first connector).
If configuration is needed, connect a USB keyboard to the USB port on the server front panel.
Press the power button.

Tip: - If the media server is restarted, close and restart Picturall Commander as well.
- If a new display is connected, restart the server and Picturall Commander.
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4 Configuration

USER MANUAL

USER MANUAL
The server can be configured from the Web configurator or by booting the server in Configuration mode.
Configuration is needed for DMX / Art-Net, display, network and media storage
settings.
USER MANUAL

4.1 Web configurator

USER MANUAL

The web configurator allows the user to configure the server from a computer connected to same network
USER MANUAL
without installing a separate control software.
To access the web configurator, launch a web browser and enter the server
IP address
in the address bar.
USER
MANUAL
USER MANUAL

Fig. 7 - Web configurator connection
All devices default IP addresses are 192.168.2.140.
Note: The Picturall Series Media Server and the computer must be connected to the same network to run the Web configurator.

4.1.1 Dashboard

Fig. 8 - Web configurator Dashboard
The Dashboard is the home page of the Web configurator. It shows general information about the media
server.
-

Click Configure server or Configurator to access server configuration.
Click on a link in the left tab to open the corresponding menu.
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4.1.2 Server configuration

USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL

Fig. 9 - Server configuration
Set server settings from the Server configuration:
-

Number of layers: Set the number of layers to use and patch to Art-Net (max 200). This affects the
number of available layers in Picturall Commander.
Max layer width and height: Set the maximum resolution to be processed by the media server.

Caution: Media with a larger resolution than the max layer size might not be displayed correctly. This does not apply
to medias encoded in AWX and PRKL.

-

Triplebuffering: check to enable Triplebuffering.
Enable sync card and genlock (Picturall Pro only): check to enable Genlock (checked by default if the
sync card is installed).

4.1.2.1 Select audio device (optional)
If the server has more than one audio card installed select the audio card in the Audio device drop down
menu in Server configuration.

Fig. 10 - Audio device selection
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4.1.3 Display configuration

USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL

Fig. 11 - Display configuration
In the Display configuration menu, set Auto mode for the whole output card or Manual display mode per
output plug:
Tip: Use the buttons Copy, Paste and Copy to all for Displays using identical settings.

4.1.3.1 Set Auto mode for the whole output card
In Auto mode, sets all plugs of the same output card (GPU) to follow EDID.
Tip: In Auto mode, connect and power all the relevant displays before booting the media server.

1. In Setup, select Auto.
2. Per output plug, select Auto to follow EDID (or Disable the output if needed).
3. If needed, select Signal: HDMI to force the HDMI signal on any DisplayPort output (adapter needed).

4.1.3.2 Set Manual mode per output plug
In Manual mode, set each output plug manually.
1. In Setup, select Manual.
2. Per output plug, select the Display mode:
o Disabled: disable the output
o Manual: set the output resolution and refresh rate manually
o Custom: select a custom display configuration
o Special: select a preset mode for display signal splitters (Analog Way DPH104, Matrox TH2GO
and DH2GO)
3. If needed, select Signal: HDMI to force the HDMI signal on any DisplayPort output (adapter needed).
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4.1.3.3 Display division

USER MANUAL

USER
MANUAL
Displays can be divided into grids of virtual displays with Display division.
This
separates all Displays into
independent displays. These displays are affected independently (Keystone, Angle, Crop). This is very useful
USERup
MANUAL
for complex screens and Led walls. Display division can also be used for setting
display signal splitters such
as Datapath X4 and FX4.
USER MANUAL

4.1.3.4 Virtual displays

USER MANUAL
Use Virtual displays when multiple logical displays are connected to one physical output, but the split is not
USER MANUAL
even. For example: multiple physical LED screens connected to one LED processor
driven by one output from
a Picturall Media Server.
USER MANUAL
In the Display configuration menu, select the number of virtual displays used in an output. The virtual
display will appear as an independent display in Commander. The area where the display content is drawn
in the display output signal is controlled by the Commander GUI Display cropping controls (see 7.9 Crop
display size page 46).

Fig. 12 - Three virtual displays in one 1980x1080 output in Picturall Commander
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USER MANUAL
USER MANUAL

4.1.4 DMX Configuration

USER
MANUAL
Picturall Series Media Servers have three fixture profiles for Art-Net / DMX
control.
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL

Fig. 13 - DMX configuration
4. Art-Net universe: Set the first universe and the rest of the layers will be patched to next universes.
If patching more than 9 layers, the server will use several Art-Net universes.
5. Art-Net subnet: Set the Art-Net subnet value (between 0 and 15).
6. Art-Net offset: Set the first channel of the first universe for layer 1.
7. DMX profile: Set the preferred DMX fixture profile (1.1, 1.0 or mini).
8. Number of DMX displays: Enter the number of the displays controlled with DMX
DMX control for the Picturall Series Media Server consists of two elements: layers and master block. The
master block controls general functions that are not specific to any layer such as choosing display preset (for
more information, see APPENDICES page 79).
Layers are patched first starting from a given offset on a given universe. Layers are patched so that they do
not split at the universe border. The following table shows the patching for 32 layers (default).
Master block is patched immediately after the layers.
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USER MANUAL
USER MANUAL
Universe

1

2

DMX

Layer

Universe

DMX
Layer
USER MANUAL
1
Layer 19
USER
MANUAL
57
Layer 20
113
Layer 21
USER MANUAL
168
Layer 22

1
57
113
168

Layer 1
Layer 2
Layer 3
Layer 4

225

Layer 5

3

USER
225MANUALLayer 23

281

Layer 6

337

Layer 7

281
Layer 24
USER MANUAL
337
Layer 25

393

Layer 8

393MANUALLayer 26
USER

449

Layer 9

449

Layer 27

1
57
113

Layer 10
Layer 11
Layer 12

1
57
113

Layer 28
Layer 29
Layer 30

168

Layer 13

168

Layer 31

225

Layer 14

225

Layer 32

281

Layer 15

281

Master Block

337

Layer 16

393

Layer 17

449

Layer 18

4

Table 3 - Example patch of 32 layers using 56ch DMX profile

4.1.5 Network configuration

Fig. 14 - Network configuration
Tip: Click Identify to make the selected ethernet connector blink on the rear panel of the unit.

There are three ways to set the IP addresses for the server:
-

Automatic (DHCP): The server gets IP address from DHCP server in the same network
Automatic (ARTNET): The IP address is generated based on the Art-Net protocol
Manual: Set the IP address and netmask manually

Caution: Never have two DHCP servers in the same network.
Caution: Set the IP address manually if Automatic (DHCP) is activated in the server.

20
www.analogway.com

USER MANUAL
4.1.5.1 Network configuration for Picturall Pro

USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL

Fig. 15 - Network configuration (Picturall Pro with dual network interface and 10GB option)
Picturall Pro has supports two different networks. Enable the Secure mode to prevent incoming connections.
Note: At least one interface must be enabled and at least one interface must be non-secure.

An additional 10GB network ethernet interface is available as an option for the Picturall Pro.
The 10GB network option can be set either to secure or non-secure network.

4.1.6 Import and Export configuration
4.1.6.1 Export configuration (save)
Tip: Export server configuration before updating the Server Software as this deletes Configuration options.

To save the current configuration:
1.
2.
3.
4.
5.

On a web browser, enter the media server IP address in the address bar.
Go to Configurator or Configure Server.
Go to Export configuration.
Choose the configuration parameters to be saved.
Click Export configuration.

The Configuration is saved in a PSC file.

4.1.6.2 Import configuration (load)
1.
2.
3.
4.
5.
6.

On a web browser, enter the media server IP address in the address bar.
Go to Configurator or Configure Server.
Go to Import configuration.
Choose the PSC file to import.
Choose the configuration parameters to load.
Click Import configuration.
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USER MANUAL
USER MANUAL

4.1.6.3 Back up the contents on another Picturall Series Media Server
USER
It is possible to back the contents of one server onto another one connected
onMANUAL
the same network.
The following example shows how to back from a Server A to a Server B.
USER MANUAL
1. Make sure the two servers have the same software version (latest if possible).
2. Make sure the two servers have Picturall Commander installed inUSER
sameMANUAL
version (latest if possible).
3. Create a show and transfer some media files on Server A.
4. Make sure that Server B is up and running.
USER MANUAL
5. On a web browser, enter the IP address of Server A in the address bar.
USER MANUAL
6. Go to Tools / Backup.
7. Select Server B in the dropdown list or enter the IP address of server B then click Save.
USER
MANUAL
Server A sends all medias and shows to Server B (configuration
settings
are not duplicated and
existing medias on server B are not deleted).
8. After the transfer is complete, restart Server B and make sure that it has the same shows and media
data as Server A.

4.1.7 Format Media Drives - Storage configuration
In Tools / Format media drives, set the hard drives formatting method.
In the following example, a Picturall Series Media Server has two hard drives of 1TB capacity.
-

RAID 0 (striped): 2TB of storage with fastest writing speed. Media drive failure loses all media files.
RAID 1 (mirrored): 1TB of total storage, medias are stored identically on both media drives. If one
media drive fails, the show continues using the other media drive. Best reliability but performance is
halved.

Recommendation: Use RAID 0 for optimal performance.
Note: - If the formatting method is modified, all media on hard drives will be deleted.
- RAID 1 is only available for Quad and Pro.

4.1.8 Conflicting Settings
Sometimes settings may conflict with each other. For example: the same Display resolution cannot be set to
1920x1080 and to automatic. In case of conflict, the most recent value is kept and the previous value is
discarded.
Settings that easily conflict in the display settings:
Settings
Auto
A special mode
A connector, a resolution or a refresh rate

Conflicts with
A connector, a resolution, a refresh rate and a special mode
Auto, or a connector, setting a resolution, a refresh rate
Auto and a special mode

Settings that easily conflict in the network settings:
Settings
An IP address and a netmask
DHCP client
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Conflicts with
DHCP client
DHCP server, an IP address and a netmask

USER MANUAL
USER MANUAL

4.2 User management

USER MANUAL
In Tools > User management, create admin user accounts to prevent other
users from accessing server
configuration settings, server tools and media manager using the web configurator.
USER MANUAL
Note: - By default and when there is no admin user account created, the access to the server settings has no password restriction.
- After adding an admin user account, logging in becomes required immediately.

USER MANUAL

- If all usernames or passwords are forgotten, it is possible to run a factory reset via Configuration mode, see page 26.

USER MANUAL
USER MANUAL
USER MANUAL

Fig. 16 - User management page

4.2.1 Create an admin user account
1. Open the web configurator and go to Tools > User management.
2. Enter a Username and passwords.
3. Click Add account.
The admin user account is created.
4. If needed, repeat steps 1 to 3 to create more admin user accounts.
After creating an admin user account, accessing menu titles visible on the front page and on the top of the
page requires to log in with an administrative account.

4.2.2 Log out - Close an admin user session
To log out an admin user account, close the browser.
Depending on the browser, it might be needed to clear the browser history or check that the browser is not
active in the background.
Tip: Use web browser’s incognito mode to make sure that the admin account is logged out when browser is closed.

4.2.3 Delete an admin user account
1. Open the web configurator and go to Tools > User management.
2. Click Delete on the corresponding user account in the users list.
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USER MANUAL
USER MANUAL

4.3 Media manager

USER
MANUAL Media manager is
Use Media manager to access media collections and media files via the web
configurator.
available in the Dashboard page and in the top bar. Use Media manager to:
USER MANUAL
• Create media collections with media files located in the media server local storage
• Upload media files to the media server media drive and directly to
the media
collections
USER
MANUAL
• Add input sources and web content to the collections
• Add a generated text to a collection
USER MANUAL
• Encode media to AWX
USER MANUAL
• Adjust media fading settings and end actions (Play mode)
Note: - Media manager web page does not contain show control user interface. Use Picturall Commander for playback settings.

USER MANUAL

- Media manager is supported in the following web browsers: Chrome, Firefox, Safari and Edge (version 79 or newer)

Fig. 17 - Web configurator – Media manager
Media collections are displayed on the left side. Server Media files, Inputs, Network sources and Generators
are displayed on the right side.
Changes made in Media manager and in Picturall Commander are synchronized. Media collections and Server
files are avaible in both pages with same fading parameters, playback order and folder structure.

4.3.1 Adding media files
-

-

Adding media to a media collection can be done by dragging media files from the server files to the
media collections.
A single file, group of files or directories can be dragged into media slot or server files folders can be
uploaded directly to the media collection by clicking an empty slot in the media collection, or
dragging and dropping content from the computer to a collection slot.
Adding an input source, URL video stream, a web page source or custom generated text to the
collection is done by draggin the source to the target collection media slot.

Note: The Media manager is very similar to the Media menu of Picturall Commander. For more information, see 6 Media page 31.

4.3.2 Upload media files to specific folders
Uploading a file directly to the collection will save the file to the Media root folder.
To upload a media file to a specific folder:
1. Click the Media folder to expand the folder tree.
2. Click Upload a file or directory under the target server folder.
It is also possible to drag and drop a file or folder on the Upload a file or a directory button.
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USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
Fig. 18 - Upload content to the server folder
USER MANUAL
A transfer dialogue will appear after the files have been selected for upload.
USER MANUAL
3. Select to maintain the original encoding or to encode the content to AWX formats. After confirming
the upload, a transfer progress bar will appear above the Media library indicating the transfer status.
Note: - Leaving the media manager or closing the browser during a media transfer will interrupt the transfer progress. Resume the transfer
by restarting the transfer process to the same media folder.
- Server reboot will remove interrupted media transfer files

4.3.3 Contextual menus
Right click a media file on the Server files side to open a contextual menu with larger media thumbnail and
options to move (cut, copy, paste), encode, delete or download a file to the connected local computer.

Fig. 19 - Media contextual menu
Right click a media in a collection will bring up options to move (cut, copy, paste), rename, edit fading settings
or remove the media from the collection.

4.3.4 Fading settings
Fading settings can be defined for each media file on the collection. Either set the fading settings directly on
the collection or right click a media and select Edit media fading settings for more precise fading controls.
Note: For more information about media end actions (play mode) and fading settings, see 6 Media page 31.
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USER MANUAL
USER MANUAL

4.4 Configuration mode

MANUAL
The Configuration mode allows the user to configure directly on theUSER
media
server using a connected
keyboard. This mode includes all the functionality of Web configurator.
USER MANUAL
To enter the Configuration mode:
1. Make sure a USB Keyboard is connected to the media server.
USER MANUAL
2. Start the server and press any key when the startup screen displays.
3. Use the arrow keys in the start menu to select Configuration USER
mode.
The Configurator menu is
MANUAL
displayed.
USER MANUAL
Configurator has three main sections: Server configuration, Display configuration,
and Network configuration.
Use arrow keys to navigate menus and use enter to select. Use the Tab button to move between different
USER MANUAL
sections.

Fig. 20 - Configuration mode
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USER MANUAL
4.5 Update Server Software

USER MANUAL

MANUAL
Caution: Picturall Commander must always be in the same version as the Server USER
software.
Update Picturall Commander
together with Server software for best compatibility and performance. A message is displayed in Picturall Commander if
the versions do not match.

USER MANUAL

Tip: Updating the Server Software resets Configuration options but medias
not deleted. Export server
USERare
MANUAL
configuration to recover it after the update (see 4.1.6 Import and Export configuration page 21).
The server comes fully installed with the server software. If a software
is needed, create an
USERupdate
MANUAL
installation USB stick and use it to update the software.
USER MANUAL
Find all installation files for the Media servers on www.analogway.com
USER MANUAL

4.5.1 Creating an installation USB stick
Tip: Use a high-quality USB memory stick, a low-quality USB memory might cause problems when installing the software.
Note: At the moment, the Picturall Series Media Server installer only runs on Windows.

On a computer:
1.
2.
3.
4.
5.
6.

Connect an empty, FAT32 formatted USB stick with at least 2GB of free space.
Go to www.analogway.com and download the Picturall installer.
Run the installer.
In the Distribution menu, select the latest version (non-beta).
Make sure the selected Drive is the USB stick.
Click OK to write the installer onto the USB stick.

The USB stick is now ready for installation.

4.5.2 Installing the server software from a USB stick
1.
2.
3.
4.
5.

Connect a USB keyboard and the installation USB stick to the server.
(Re)boot the server.
When booting, enter Boot menu by pressing F8 (Twin and Quad) or F12 (Pro).
Select the non-UEFI version of the USB stick. The installer starts.
Follow the instructions displayed on the screen.

After the installation, the server reboots and sends a test image with server IP address and display number
is sent to every connected display.
6. If needed, go to the Network configuration > Manual and set new IP address.
7. If needed, import saved Configuration.
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USER MANUAL
USER MANUAL
5 Configure Picturall Commander
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL

Fig. 21 - Picturall Commander
Picturall Commander is the software (Java application) used to control the Picturall Series Media Server. This
chapter describes the installation and the top-level parts of the Picturall Commander user interface.

5.1 Java compatibility
Starting from version 2.8.0, Picturall Commander is bundled with Java. Installing Java separately is no longer
required.
Note: For versions prior to 2.8.0, the operating systems must support Java version 8 for Picturall Commander to be installed. Make sure
Java version 8 is installed on the computer before installing Picturall Commander, or use the latest version of Picturall Commander.

5.2 Installing / Updating Picturall Commander
Caution: Picturall Commander must always be in the same version as the Server software. Update Picturall Commander
together with Server software for best compatibility and performance. A message is displayed in Picturall Commander if
the versions do not match.
Tip: Use a dedicated computer for running Picturall Commander. This ensures that the show files are safe at all times.

The software is on the USB stick delivered with the server. The latest version of Commander is automatically
downloaded during the installation process.
If needed, the latest version of Picturall Commander can also be downloaded from www.analogway.com.
To install Picturall Commander, follow these steps:
1.
2.
3.
4.

On the computer, insert the USB stick delivered with the media server.
Copy the installer file matching the operating system from the USB stick to the computer.
Run the installer file and follow the instructions to complete the installation process.
If needed, open Picturall Commander and go to File / Load show to load previous configuration.
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USER MANUAL
5.3 Connecting to Picturall Series Media Server

USER MANUAL

MANUAL
Caution: If the computer goes into a standby mode, the connection to the server isUSER
lost after
the computer resumes.
Tip: If the media server is restarted, close and restart Picturall Commander as well.

USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL

Fig. 22 - Add new connection dialog
1. Connect the computer and the Picturall Series Media Server to the same network.
2. Use same netmask in the server and the computer if not using DHCP server. If DHCP server is enabled
in the server, use automatic network settings in the computer.
3. Run Picturall Commander and click

Add new connection on the Connections tab.

4. Type the IP address of the server in the Address field or click Locate to automatically find the servers
in the same network and view the server versions before connecting.
5. In the Name field, enter a name for the connection.
6. Under Advanced, change the values for Text protocol port and Data protocol port if needed.
7. If needed, uncheck Connect immediately.
8. Click Finish to Create the Connection. A message confirms the connection to the Picturall Series
Media Server.

5.4 User Interface
The Picturall Commander user interface consists of a few basic elements:
-

The main Commander toolbar.
The control tabs.
The control panels within the tabs.

The control tabs are positioned in the right, middle, left or bottom depending on their function.

5.5 Control Tabs
Click Window then click any menu to open the corresponding control panel.
-

Connections: Connect and reconnect to a server pressing Reconnect button. The main control tabs
are available in the Connections tab.
Media: Transfer media files to the Picturall Series Media Server and arrange the media library. For
more information, see Media page 31.
Displays: Configure the display setup. For more information, see Displays page 40.
Displays Graph: Open the Display Graph in a whole tab for precise adjustment, see Displays page 40.
Genlock (only for Picturall Pro equipped with optional sync card): Check / Resync the genlock.
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USER MANUAL
-

Layers: Control all layer parameters. This is the main menu for controlling
the Picturall Series Media
USER MANUAL
Server with Picturall Commander. For more information, see Layers page 47.
USER MANUAL
Layers Graph: Open the Layers Graph in a whole tab for precise adjustment,
see Layers page 47.
GPUs: Optimize the use of the GPUs.
USER MANUAL
Timecode: Set the timecode format and offset.
Cues: Program and time cues for the show.
USER MANUAL
Test images: Configure test images to help when setting up the show.
Performance: Check the performance and temperature of the server.
more information, see
USERFor
MANUAL
Performance page 74.
Control model: Shows a tree structure of all the parameter information
on the server.
USER MANUAL
Server info: Opens a window with all server information.
USER
MANUAL
Properties: Shows additional information on a given selected item.
Located
in Window > Properties.

Tip: Open these menus in one click from the menu icons toolbar:

5.5.1 Arrange windows
Once a panel is opened, drag and drop a tab to customize the layout.
All tabs can be placed anywhere in the layout (top, bottom, left or right).

Fig. 23 - Windows arrangement

5.5.2 Reset windows
If needed, reset the default layout by clicking Window/ Reset windows.

5.6 Preferences
Go to Edit > Options to set user preferences (General, Media, Layer, Cue, Keymap and Logging).

5.7 Hotkeys
Hotkeys can be set to several actions in Picturall Commander. Go to Edit > Options > Keymap to set custom
hotkeys. Here is a list of common features using default hotkeys:
•
•
•
•
•

Hold Shift while adjusting values to make fine adjustments to numerical sliders and control.
Hold Alt and click parameter values or other settings to record or unrecord it in the Programmer. The
value turns green if it is recorded. For more information, see Program a Show - Cue page 62.
Hold Ctrl and click a parameter to reset it to default value. (Use cmd on Mac OS).
Use Alt + arrow keys on the keyboard to change the selected control point on the Warp and Keystone
tabs.
Use Ctrl and click to reset a single control point on the Warp and Keystone tabs.
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USER MANUAL
6 Media

USER MANUAL

USER MANUAL
In the Media menu, manage all contents that will be played during the show:
-

import files to the server,
USER MANUAL
encode medias,
USER MANUAL
add web pages and video streams,
organize server files and inputs in collections to be used in layers.
USER MANUAL
USER MANUAL
USER MANUAL

Fig. 24 - Picturall Commander Media menu
The Media menu can be customized to show the media columns as needed. Right click a media library column
name and select which columns to display or hide.
Tip: Media manager can also be found from the web configurator (see chapter 6.9)

6.1 Media types
Picturall Series Media Servers support the following codecs:
•
•
•
•
•
•
•
•
•
•
•

AWX (also with alpha channel)
HAP
NotchLC
ProRes
MPEG1
MPEG2
MPEG4
MJPEG
H.264
H.265
PRKL (also with alpha channel)

•
•
•
•

JPEG
PNG (also with alpha channel)
DPX (also as sequences)
TGA (also as sequences)

AWX is a format designed by Analog Way specifically for the Picturall Series Media Servers. Encoding high
resolution files (4K and higher) to AWX format is recommended for optimal performance.
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USER MANUAL
All codecs can be played with nearly any frame rate and bit rate within the
server
performance limits.
USER
MANUAL
Audio is supported in PCM, WAV and AAC formats (up to 24 output channels).
USER MANUAL

6.2 Importing and encoding Media files

USER MANUAL

Tip: If running Picturall Commander on Windows, it may be needed to disable the firewall to transfer files smoothly.
Note: The amount of free space on the server is displayed in the Free server space bar.

USER MANUAL

6.2.1 Import a local media file

USER MANUAL

To import a local media file to the server:

USER MANUAL

1. Select a media file in the Local path list or computer file browser. Hold Ctrl or Shift to select multiple
USER MANUAL
files.
2. Drag and drop it on the media collection slot to use.

Fig. 25 - Importing a media file
3. The Local files to be transferred window opens with a list of the importing files. If needed, set target
directory and filename.
4. Click OK. The current transfer and encoding process bars are displayed on the Transfers subtab.
Note: After a file is imported on the server, it is impossible to change its filename and location.

If importing multiple folders, Picturall Commander puts all folders into their own media collections.
5. If needed, use Cancel buttons for canceling file transfer.
Medias added to the server are displayed in the Media collection and are available in Server path files.
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USER MANUAL
6.2.2 Import and encode a file to AWX format

USER MANUAL

USER
MANUAL
Tip: For optimal performance, encode 4K and higher files to AWX format (and AWX
Alpha
if alpha channel).
Note: Encoding is only applicable for original video files (no image and no PRKL or AWX file).

1.
2.
3.
4.
5.
6.

USER MANUAL
Select a media file in the Local path list or computer file browser. Hold Ctrl or Shift to select
USER MANUAL
multiple files.
Drag and drop it on the media collection slot to use.
USER MANUAL
The Local files to be transferred window opens with a list of the importing
files. If needed, set
target directory and filename. Then click OK.
USER MANUAL
In the Default encoding dropdown, select AWX format (or AWX Alpha).
Click OK. The current transfer and encoding process bars are displayed
on the Transfers subtab.
USER MANUAL
If needed, use Cancel buttons for canceling file transfer.

Medias added to the server are displayed in the Media collection and are available in Server path files.

6.2.3 Import an image sequence
Picturall Commander is able to convert images and create an image sequence as one media object with
uncompressed image quality.
Tip: - An image sequence must have at least 49 frames.
- Images must have the same filename ending in 000, 001, 002, etc. to be detected as a sequence.

To import an image sequence, follow these steps:
1. Select the images files in the Local path list or computer file browser. Hold Ctrl or Shift to select
multiple files.
2. Drag and drop it on the media collection slot to use.
Tip: Group the images in one folder then drag and drop the whole folder.

The Local files to be transferred window opens with a list of the importing files.
3. Enter the number of Frames per second (FPS).
4. If needed, select the encoding format and choose to keep the original images on the server as
individual files.
5. If needed, set target directory and filename.
Note: After a file is imported on the server, it is impossible to change its filename and location.

6. Click OK. The current transfer and encoding process bars are displayed on the Transfers subtab.

6.2.4 Import a media using FTP
Caution (Risk of server crashing): Do not overwrite files that are playing on the server through an FTP connection.
Tip: Importing media using FTP can slow down the media server. Avoid transferring large files during a show or while
making changes to the configuration.

To import media through FTP connection, follow these steps:
1. Open an FTP connection to the Picturall Series Media Server.
2. Log in:
- Username: picmedia
- Password: aidemcip
3. Import the media files to the server. The media are located in /picturall/media.
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USER MANUAL
USER MANUAL

6.2.5 Reuse imported media files - Add server files to a media collection
USERthese
MANUAL
To add media files already present on the server to a media collection, follow
steps:
1. Select a media file in the Server path list. Hold Ctrl or Shift to select multiple files.
USER MANUAL
2. Drag and drop it on the media collection slot to use.
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL

Fig. 26 - Add a server file to a media collection
3. If adding multiple folders, Picturall Commander will automatically put all folders into their own media
collections.

6.2.6 Encode a media present on the server
Tip: For optimal performance, encode 4K and higher files to AWX format (and AWX Alpha if alpha channel).
Note: Encoding is only applicable for original video files (no image and no PRKL or AWX file).

1.
2.
3.
4.
5.
6.
7.

Right-click a media file in the Server path list. Hold Ctrl or Shift to select multiple files.
Click Encode files…
The Remote files to be encoded window opens with a list of the encoding files.
In the Default encoding dropdown, select AWX format (or AWX Alpha).
If needed, set target directory and filename. Then click OK.
Click OK. The current encoding process bars are displayed on the Transfers subtab.
If needed, use Cancel buttons.

Tip: Right-click a media file and click Encode to > Encode to AWX to quickly encode to the same location and with the
same filename.
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USER MANUAL
USER MANUAL

6.2.7 Encoding media to AWX format without a Picturall Series Media Server
USERAWX,
MANUAL
Using Adobe Creative Cloud with AWX plugin, media files can be encoded into
AWX HQ and AWX Alpha
format without using a Picturall Series Media Server.
MANUAL
The free AWX encoder plugin for Adobe CC suite is available for downloadUSER
on www.analogway.com.
Note: - AWX plugin is available for Adobe Media Encoder and Adobe Premiere.

USER MANUAL

- An active license for Adobe CC is needed. Visit https://www.adobe.com/creativecloud.html or refer to Adobe website.

6.2.7.1 Install AWX plugin

USER MANUAL

USER MANUAL
Download the installer for Windows or MAC and install the plugin to your system. The applicable Adobe
products must be installed before installing the plugin. Start the install process
and Install the plugin in the
USER MANUAL
Adobe plugins folder.

Fig. 27 - AWX plugin installation (Windows)

6.2.7.2 Export a video in AWX format
1. After the installing the AWX plugin, run Adobe CC Media encoder.
2. In Export Settings, select AWX format.
3. In the Video tab, set video settings and select which AWX codec to use in the Codec dropdown menu.
Files encoded to AWX format is ready to be uploaded to a Picturall Series Media Server for playback.

Fig. 28 - AWX plugin encoding options
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USER MANUAL
6.3 Edit server filenames and location

USER MANUAL

USER MANUAL
Editing server filenames and location is only possible when using an FTP client.
1. Open an FTP connection to the Picturall Series Media Server.
2. Log in:
- Username: picmedia
- Password: aidemcip
3. Go to /picturall/media. The Server files are displayed.
4. Edit the media filenames and location

USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL

6.4 Add inputs to a media collection

USER MANUAL

Note: Inputs are only available for Media Servers equipped with optional input cards.

An input is available as a Server File if it is connected to the media server.
To add an input to a media collection, follow these steps:
1. Select an input in the Server path list. Hold Ctrl or Shift to select multiple inputs.
2. Drag and drop it on the media collection slot to use.

6.5 Add web pages and video streams
6.5.1 Add a web page to a media collection
Picturall Series Media Servers connected to the internet support web page playback. Multiple web pages can
be played at the same time and background transparency is supported.
Note: Web page sound and interaction are not supported.

To add a web page to a media collection, follow these steps:
1. In the Server path list, under Network, select Web page.
2. Drag and drop it on the media collection slot to use.

Fig. 29 - Add a web page to a media collection
3. A window opens, enter the Web page address (URL), the reload timing and the browser window
width and height in pixels.
4. Click OK.
Note: After a web page is added to a collection, it is impossible to change its URL.
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USER MANUAL
6.5.2 Import a web page using FTP

USER MANUAL

USER
MANUAL
Caution (Risk of server crashing): Do not overwrite files that are playing on the server
through
an FTP connection.
To import a web page through FTP connection, follow these steps:
1. Open an FTP connection to the Picturall Series Media Server.
2. Log in:
- Username: picmedia
- Password: aidemcip
3. Import the files to the server.
The imported files are located in /picturall/media/.webpages/.

USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL

6.5.3 Add FTP imported web page to a media collection
To add an FTP imported web page:
1.
2.
3.
4.
5.

In the Server path list, under Network, select Web page.
Drag and drop it on the media collection slot to use.
A window opens, enter the URL to the html file starting with http://localhost/webpages/
Enter the browser window width and height in pixels.
Click OK.

Note: After a web page is added to a collection, it is impossible to change its URL.

6.5.4 Add a URL video stream to the server
Picturall Media Servers connected to the internet support video stream playback (URL):
- RTSP (rtsp://)
- RTMP (rtmp://)
- SRT (srt://)
- UDP (udp://)
To add a video stream to a media collection, follow these steps:
1.
2.
3.
4.
5.

In the Server path list, under Network, select Video stream.
Drag and drop it on the media collection slot to use.
A window opens, enter the Video stream URL.
If using RTSP, set transport parameters.
Click OK.

Note: After a video stream is added to a collection, it is impossible to change its URL.

6.5.5 Add an NDI video stream to the server
Note: NDI™ is a trademark of NewTek, Inc. For more information, see https://ndicentral.com/
- NDI™ streams connected on the network are available in the Server path.
- Audio is not supported for NDI streams.

To add an NDI video stream to a media collection, follow these steps:
1. In the Server path list, under Network > NDI, select and available NDI video stream.
2. Drag and drop it on the media collection slot to use.
A window opens with the URL already entered.
3. Click OK.
37
www.analogway.com

USER MANUAL
6.6 Add a custom text

USER MANUAL

Create a text with custom settings (font, style, size, color and resolution).USER MANUAL
To add a custom text to a media collection, follow these steps:

USER MANUAL

1.
2.
3.
4.

In the Server path list, under Generators, select Text generator. USER MANUAL
Drag and drop it on the media collection slot to use.
A window opens, enter a text and set the parameters.
USER MANUAL
Click OK.
MANUAL
To edit a custom text, right-click it in the Media tab or in the Layers tab inUSER
Media
selection then choose Edit.

6.7 Manage Media Collections
-

USER MANUAL

Select a media collection in the Media collection dropdown on the top part of the Media tab.
Rename the media collection using the Rename… button.
To delete a media from a collection, right-click it and select Delete.
To delete all medias from all collections, click the Reset… button.

6.8 Default Media transition
Define a default media transition from the Media collection.
Note: Media transition can also be set in the Layers menu.

6.8.1 End action (Media)
To define the default action at end of the playback of one media, click the dropdown in the Play mode column
and select an end action.
End action

Description (at the end of the media)

Loop
Loop collection

Loop the media file.
Play the next media in collection and loop. At the end of the last media, replay the
collection from the first media.
Play the next media in collection. At the end of the last media, stop the playback.
Pause the playback (still frame).
Stop the playback (no frame).

Next
Pause
Stop
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USER MANUAL

6.8.2 Media Crossfade

USERtime
MANUAL
During a Crossfade, the Media Server starts to play the next media at the same
as the end of the current
one for a smooth crossfade.
USER MANUAL
To define the default crossfade setting for one media, click the dropdown in the Crossfade column and select
USER MANUAL
a Crossfade style or right-click a media and select Edit media fading settings.
USER MANUAL
USER MANUAL
USER MANUAL
Fig. 30 - Media Crossfade settings

Crossfade setting

Description

Crossfade type
Duration
Smoothing

Select a transition between the available Crossfades styles.
Set the crossfade duration in seconds.
Set the smoothness of the fade from 0 to 1. 0 is sharper and 1 is smoother.

Note: - If the two medias have different frame rates, the transition uses the highest frame rate.
- Audio crossfade is always linear.

6.8.3 Media Fade in / Fade out
Media can be set to fade in at the beginning of the playback and/or fade out at the end. Default values for
fade in and fade out can be set with a right-click on a media and select Edit media fading settings.
Tip: Enable Fade at loop point to automatically fade when looping.

Fig. 31 - Media Fade in/Fade out settings
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7 Displays
In the Displays menu, configure the displays of the show.

USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL

Fig. 32 - Picturall Commander Display Menu
1. Select a display from the Display list.
2. At the right of the Display list, there are control panels to adjust the display. Click the tabs (Pos, Proj,
etc.) to show or hide the corresponding panels.
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7.1 Display menu icons
Icon

USER MANUAL
USER MANUAL

Description

USER MANUAL
Show / hide the display list.
USER MANUAL
Select all enabled displays.
USER MANUAL
Enable selected displays.
Disable selected displays.

USER MANUAL
USER MANUAL

Opens the Display wizard to create a group of displays (see Multi-display screen - Display wizard
page 43).
Blend the selected group of displays (see Multi-display screen - Display wizard page 43).
Enable/disable adjusting selected displays as a group.
Enable/disable adjusting single display as a group.
Set current state as a default, adjustments become relative to this state.

7.2 Display adjustment tabs
Adjustment tab

Description

Positioning
Projection
Edge blending
Angle
Keystone
Warp
Color correction
Cropping

Place, transform, and enable/disable displays
Flip and mirror
Edge blending functions
Distortion (for example to correct a projection onto a screen from an angle)
Keystone
Curved surface projection
Display color correction
Crop the display

7.3 Test images
Picturall Commander provides test images to help setup.
-

Double-click the Test images button on the Connections tab (or click the icon in the menu
toolbar) to open the Test images tab on the right side.
Select the test images to be displayed.
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USER MANUAL
USER MANUAL

Test image

Description

Line width
Blue background

USERbar.
MANUAL
Adjust the line width in a test image using the slide
Show display areas that are not drawn in blue. Use when adjusting Keystone or
USER MANUAL
curved surface correction.
Show white continuous grid across the composition.
Also shows yellow X in the
USER MANUAL
middle of composition. Use for final adjustments.
Show multicolored lines in selected angle. UseUSER
the checkboxes
MANUAL for defining the
line orientation. Use when adjusting display positions and bezel corrections.
USER
MANUAL
Show display borders, edge blend area and edge
blend
center.
Use when adjusting edge blends.
USER MANUAL
Show display borders with white lines. Use when adjusting keystone.
Show the display number of each display. Use to identify displays and make sure
they are properly connected.
Show grid and middle point of selected display. Use when adjusting angle and
curved surface corrections.
Show selected control points on the output. The selected control point turns
from green to red on the output. If selecting multiple points, only one point turns
red.
Show layer borders and/or numbers. Use to identify layers and help position
them in the show.
Show server IP address, display number, output resolution and system runtime.
This test image is enabled on first boot, and after Media Server update.

Canvas grid
Canvas lines
Blend areas
Display borders
Display numbers
(Selected) Display grid
Control points

Layer borders /
Layer numbers
System info

Table 4 - Test images

7.4 Positioning and Grouping Displays
1. Select the display to control in the Display list.
2. Open the Positioning panel and adjust the position, size, aspect ratio and rotation for the display.
Drag or scroll to adjust the values (hold Shift for precise adjustments).

Fig. 33 - Positioning panel
3. If needed, open the Projection panel to mirror and flip the image.
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USER MANUAL
Tips: - Right-click a parameter and select Edit to enter numerical values.

USER MANUAL

- Position the displays from the same graphics card close to each other to avoid performance loss.
- For best performance, disable displays when they are not used.

USER MANUAL

- Copy and paste settings from one display to the other by selecting displays and clicking Copy and Paste buttons.

USER MANUAL

It is possible to copy and paste one object over several objects and vice versa.

USER MANUAL

- Go to Windows / Displays Graph to open the display graph in a separate tab.

7.4.1 Multi-display screen - Display wizard

USER MANUAL

MANUAL
Displays can be arranged in groups to allow control of multiple displaysUSER
at once.
The Display wizard helps
creating screens made with multiple displays.
USER MANUAL

Fig. 34 - Display wizard
1. Click the Display Wizard button

in the Edge blending panel, or in the Displays tab toolbar. If

displays are selected, they are automatically added to the Selected displays field.
Preselected displays appear in order of selection.
2. In the Selected displays field, enter the displays in order (1,2,4,8) or just the first one if they are
ordered logically.
3. Enter the Grid size and display aspect ratio.
4. If needed, create a Blending and set the blending size (see Edge Blending page 44).
5. If needed, use Bezel correction to correct video wall bezels. Enter the display total dimensions and
bezel width and height.
6. Click OK to create the display group.
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USER MANUAL
USER MANUAL

7.4.2 Reset Display
-

USER MANUAL
Hold Ctrl and click a field to reset the value.
Use the Adjustment tab Reset button to reset the corresponding parameter for the selected
USER MANUAL
display.
Use the Upper right Reset button to reset all parameters from the selected display.
USER MANUAL
Use the Reset all button to reset all displays.

7.5 Optimize pixel space - GPUs tab

USER MANUAL

USER MANUAL
Pixel space optimization is a calculation that optimizes graphic card performance
with the current display
setup. It ensures best performance and sharpest image.
USER MANUAL
By default, automatic pixel space optimization is triggered every 5 seconds.
To change it to 1 second or to disable it, go to Edit > Options.
If auto optimization is disabled, it is still possible to trigger an optimization manually:
- Open the GPUs menu and click Optimize.
Note: For more information about GPU optimization, see Optimize GPU resolution and drawing performance page 88.

7.6 Edge Blending
Edge blending is a feature that gradually fades out the overlapping area from both projectors to create a
seamless projection.

7.6.1 Keystone and Angle Correction
The Keystone correction tool moved the picture corners on the display. Use Keystone when the projection
angle is not optimal.

Fig. 35 - Keystone and Angle correction
1.
2.
3.
4.

Open the Test images tab and enable the Display borders test image.
Go to Displays and select the display to control in the Display list.
Open the Keystone panel.
Click and drag the corners to correct the position or click the corner and use arrow keys to move it.
It is possible to select multiple points. Hold the Shift key for more precise adjustments.
5. If needed, open the Angle panel to correct the image with Angle controls.
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USER MANUAL
6. Enable the Display grid test image.
USER MANUAL
7. Adjust X angle and Y angle controls until the red cross is in the middle of the projection.
USER MANUAL

7.6.2 Edge Blending panel

MANUAL
1. Open the Test images side panel and enable the Blend areas testUSER
image.
USER MANUAL
2. Open the Edge Blending panel, then click the Display Wizard button
to create a display grid.
3. Check the Create blending group box to group the displays and click
OKMANUAL
to create the group.
USER
4. In the Displays list, select the first display of the group.
5. In the Edge blending control panel, use the Left, Right, Top and Bottom
controls to set edge blending
USER MANUAL
size. Hold Shift for precise adjustment or right-click to enter a value.
MANUAL
6. Adjust the value until the red line overlaps with the border of theUSER
adjacent
display.
7. Select the other displays of the group and repeat the adjustment step (red line overlap).
8. When all overlaps are done, click the Blend button to enable edge blend.
9. Open the GPUs menu, click Optimize for best performance.

Fig. 36 - Edge blending panel
Tip: If blend area is brighter or dimmer than rest of the picture, use the Gamma setting to correct the image. The color
correction is also possible with the RGB controls.
Note: When clicking Blend, the displays overlap and sizes are automatically calculated from blend values. The result is displayed on the
Positioning area.

7.6.3 Edge blending example
The following is an example for making a three-projector blend of displays 1, 2 and 3:
1. Open the Test images side panel and enable the Blend areas test image.
2. Open the Edge Blending panel, click the Display Wizard button
3.
4.
5.
6.
7.
8.
9.

to create a display grid.

Enter Display number (1), Grid size (3x1) and Aspect ratio (16:9).
Check the Create blending group box to group the displays and click OK to create the group.
In the Displays list, select Display 1 and open the Edge blending control panel.
Adjust the Right value until the red line overlaps with the left border of Display 2.
Select Display 2 and adjust Left and Right until overlap.
Select Display 3 and adjust Left until overlap.
Click Blend to enable the edge blend.
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USER MANUAL
10. If needed, correct the Gamma and RGB.
11. Open the GPUs menu, click Optimize for best performance.

USER MANUAL
USER MANUAL

7.7 Adjust curved surface projection - Warp correction

USER MANUAL
Warp correction transforms the display for curved surface projection or projector lens distortion. There are
16 control points.
USER MANUAL
Tip: Use the Display borders, Display grid and Canvas grid test images.

USER MANUAL
1. Go to Displays and select the display to control in the Display list.
2. Open the Warp panel.
USER MANUAL
3. Click and drag a point to correct the position or use arrow keys to move it. It is possible to select
multiple points. Hold the Shift key for more precise adjustments. USER MANUAL
Use Alt + arrow keys to change the selected control point, and Ctrl + click to reset a point.

7.8 Color correction (Display)
7.8.1 Adjust display color
Adjust color correction independently for each display.
1. Go to Displays and select one or more displays in the Display list.
2. Open the Color Correction panel to set the Gamma, Saturation, Contrast and Brightness levels for
each display.
3. Red (R), Green (G), and Blue (B) values can be adjusted for contrast and brightness separately.

7.8.2 Alpha display
Force a display to Alpha drawing mode.
1. Go to Displays and select one or more displays in the Display list.
2. Open the Color Correction panel and enable Alpha only.
3. If needed, enable Alpha invert.

7.9 Crop display size
Use Cropping to limit the size of the display. With cropping tool the area of interest can be set for a virtual
displays set in the display configuration.
Tip: Use Cropping with LED walls with non-scaling processors and custom resolution.

1. Go to Displays and select the display to control in the Display list.
2. Open the Cropping panel. The values in Resolution gives the original width and height of the display.
3. Set Cropping enabled to Yes. Adjust the cropping values even if cropping is disabled.
Note: Cropping is enabled by default with virtual displays.

4. Set the X and Y position values for the display and limit its size in Height and Width to make the
display smaller than its normal size.
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8 Layers

USER MANUAL

USER MANUAL
In the Layers menu, control and program layers. Layers are the elements containing the medias, one layer
contains one media.
USER MANUAL
Note: - The Layer menu is not needed if using external controller (lighting consoles or show control systems).

USER
- Playing back too many large resolution files may cause playback issues or even a unit crash.

MANUAL

USER MANUAL
USER MANUAL
USER MANUAL

Fig. 37 - Picturall Commander Layers menu

8.1 Layers tab
8.1.1 Layer List
The layers are listed on the left panel. Right click a layer to show quick interactions (Rename, Play, etc.)
Tip: Rename the layers for easier use.

8.1.2 Layer Priority
The layers a listed from 1 to 32. By default, the layer number defines its priority. If layers overlap on the
composition, the layer with the highest number is displayed on the overlap area. It is possible to override the
layer priority with Advanced settings, see Advanced page 52.
Tip: Use the layers wisely and create the layers from background to foreground.

8.1.3 Layers adjustments
Adjustment panel

Description

Composition
Color correction
Media Selection
Effect 1 and 2
Advanced
Macros
Geometry

Preview the media and set position, rotation, intensity for each layer
Layer color correction
Browse media collection, assign media to layer, play back and end action
Select layer effects
FPS and layer synchronization settings
Save layer settings
Warp, Keystone and Edge Blending for each layer
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8.2 Select and play a media - Media selection

USER MANUAL

In Media Selection, assign a media to a layer and choose playback mode.USER MANUAL
1.
2.
3.
4.
5.
6.

Go to Layers and select the layer to control in the Layer list.
Open the Media panel.
Select a collection in the dropdown.
Double-click a media to select it.
Click the Play button. The Media is displayed.
In Media end action, select the action at the end of playback.

Tip: - Click the Pin button to go to current Media location.
- Click the Toggle view button to toggle between List and Thumbnail.

USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL

8.2.1 Playback control
Playback button

Description

Play
Pause
Stop
Set in and Set out
points
Go 10 (20 or 30)

Play/Resume video from the current frame.
Pause the video and leaves a still image of current visible frame.
Stop media playback and returns to the media start point.
Use current position as start and end points for the media. It is possible to set the In
and Out points on the playback bar by dragging the points or right-clicking on the bar.
Set the current playback position to X seconds before the end.

8.2.2 End action (Layer)
Select what the player does when the playback reaches the end of a media. The end action set in Layer
overrides the one set in the Media menu.
End action

Description (at the end of the media)

Default
Loop
Loop collection

Follow the media file Play mode set in the media collection.
Loop the media file.
Play the next media in collection and loop. At the end of the last media, replay the
collection from the first media.
Loop the collection in random order.
Play the next media in collection. At the end of the last media, stop the playback.
Pause the playback (still frame).
Stop the playback (no frame).

Random
Next
Pause
Stop

8.2.3 Layer fading settings
Layer fading settings are located under the Playback controls in the Media selection. The fading set in Layer
overrides the one set in the Media menu. To open the settings for one media (and not the layer), right-click
a media then click Edit media fading settings.

48
www.analogway.com

USER MANUAL
8.2.3.1 Layer Crossfade

USER MANUAL

USER Server
MANUAL
Select the transition between two media played in the same layer. The Media
starts to play the next
media at the same time as the end of the current one for a smooth crossfade.
USER MANUAL
Crossfade setting Description
USER MANUAL
Layer Crossfade
Select a transition between the available Crossfades styles. (Default follows the
crossfade set in the media collection)
USER MANUAL
Duration
Set the crossfade duration in seconds.
Smoothing
Set the smoothness of the fade from 0 to 1. 0 is sharper
1 is smoother.
USERand
MANUAL

8.2.3.2 Layer Fade in / Fade out

USER MANUAL

Set the fade in and fade out settings for all medias in one layer (or a selection of layers).
Fade setting

Description

Layer fade in

Select Layer to enable a fade in at the start of every media played on this layer.
(Default follows the fade in set in the media collection).
Set the fade in duration in seconds (the fade out duration is always 1 second).
Select Layer to enable a fade out at the end of every media played on this layer.
(Default follows the fade in set in the media collection).

Duration
Layer fade out

8.3 Composition
In Composition, adjust the layer position, scale, and rotation on the display.
Click then drag or scroll to adjust the values (hold Shift for precise adjustments).
1. Go to Layers and select the layer to control in the Layer list.
2. Open the Composition panel. If a media is playing, its thumbnail is shown in the Graph.
3. Use the adjustments to control the layer.
Tips: - Right-click a parameter and select Edit to enter numerical values.
- Copy and paste settings from one layer to the other by selecting layers and clicking Copy and Paste buttons.
It is possible to copy and paste one object over several objects and vice versa.
- Go to Windows / Layers Graph to open the layers graph in a separate tab.

Adjustment

Description

Intensity
Pos X and Y
Scale
Scale height
Rotation
Rot. speed

Transparency (opacity) of the layer
Horizontal and Vertical position of the layer. 0 is the center of the composition.
Size of the layer scaled on the full composition. 1 fills the composition horizontally.
Height of the layer scaled on the Scale value. 1 keeps the original aspect ratio.
Rotate the layer (360 degrees).
Enable a continuous rotation of the layer. Set the speed of the rotation (set negative
value to rotate clockwise).
Set how this layer is drawn compared to other layers.

Draw mode

Note: For more information on position coordinates, see Canvas and coordinates page 88.
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USER MANUAL
USER MANUAL

8.3.1 Draw modes

MANUAL
Draw mode determines how a layer is drawn and how it affects the layersUSER
beneath
it.
The following table describes the different draw modes:
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
-

Fig. 38 - Draw mode example images
USER MANUAL
Layer 2 (L2) is always on top of Layer 1 (L1).
The Draw mode of L1 does not affect L2 (L1 is set to Replace in the following examples).
Changing the Draw mode of Layer 2 gives different results.

Effect

Image

Description

Replace

Equation: L2
Default mode. Draw the layer on top of layers
below. The layers below the drawn layer are
not visible (except alpha channel).

Additive

Equation: L1+L2
Add the pixel values of the drawn layer to
layers below it (brighter image). White areas
in either layer stay white.

Subtract

Equation: L1-L2
Subtract the pixel values of the drawn layer
from layers below it (darker image). Black
areas on L2 leaves L1 unmodified. White
areas on L2 become black areas.

Darken

Equation: min(L1,L2)
Compare the drawn layer to layers below it.
The darker pixels of the result are drawn.

Lighten

Equation: max(L1,L2)
Compare the drawn layer to layers below it.
The brighter pixels of the result are drawn.

Multiply

Equation: L1xL2
Multiply drawn layer pixel values with layer
below it (darker image). Black areas on either
layer will result black areas. This mode is
useful when creating masks.
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USER MANUAL
Linear burn

USER MANUAL
Equation: L1+L2-1
MANUAL
Variant of theUSER
Subtract
mode. The result is a
darker image.
USER MANUAL

Screen

USER MANUAL
Equation: 1-(1-L1)x(1-L2)
Opposite of the
multiply
mode. The result is a
USER
MANUAL
brighter image.
USER MANUAL
Table 5 - Draw modes

USER MANUAL

8.3.2 Graph
Icon

Description
Show / hide the layers graph.
Show / hide all layer numbers on the graph.
Show / hide all enabled display numbers on the graph.
Show / hide all enabled displays on the graph.

Adjust the layer from the graph:
-

Drag the layer to set Position.
Use the handles in the right corners to scale and rotate the layers.

8.3.3 Composition Advanced settings
Under Advanced (in Composition), set the layer Draw priority, Deinterlacing and Scaling algorithm.
-

Draw priority: Set a number to override the layer number priority system (see Layer Priority page
47). By default, all layers have a Draw priority at 0. Draw priority values goes from -5 to 5.
For example: a layer with draw priority set at 1 is displayed on top of all layers with draw priority
under 1, no matter the Layer number. If layers have same Draw priority, the Layer number defines
the priority.
Tip: Use draw priority wisely to have a clear configuration. Prioritize using layer numbers and use draw priority for rare
exceptions (force layer on foreground or background).

-

Deinterlacing: Select the Deinterlacing mode (No deinterlacing, Line doubling or Blending).
Scaling algorithm: Select the Scaling technology (Bilinear, Cubic weighted, Quintic weighted,
Sinus weighted or Bicubic).
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8.4 Color correction (layer)

USER MANUAL

Adjust color correction independently for each layer.

USER MANUAL

1. Go to Layers and select one or more layers to control in the Layer list.
USER MANUAL
2. Open the Color Correction panel to set the Gamma, Saturation, Contrast and Brightness levels for
each display.
USER MANUAL
3. Red (R), Green (G), and Blue (B) values can be adjusted for contrast and brightness separately.
USER MANUAL

8.5 Advanced
In Advanced, set the frame rate values and synchronize the layers.
Note: Frame rate can be modified only if no audio track is embedded to the media.

USER MANUAL
USER MANUAL

8.5.1 Synchronize to another layer
This feature makes one layer follow the framerate of another layer or a MIDI timecode (MTC).
1. Go to Layers and select one or more layers to control in the Layer list.
2. Click Sync selected
3. Select the layer or MTC to be the source for the current layer.
Note: By default, the layers do not synchronize to any source.

8.5.2 Set layer Frame rate
Note: Frame rate can only be set if:
-

the layer is not part of synchronization.

-

the media file doesn't have audio track (even if audio is disabled).

-

and media is not a stream video or input.

Modified frame rate (or FPS) can be defined or relative to original frame rate.
Adjustment

Description

Effective FPS
FPS controllable
FPS mode
Defined FPS
Relative FPS
Frame blending

Current effective FPS of the playback with the following settings applied.
Yes or No. Displays if the frame rate can be modified.
Select Media to use media original frame rate or Defined to use manual value.
Set absolute frame rate (number of frames per second).
Set a frame rate relative to the original frame rate (from 0.10 to 2.00).
Set to Enabled or Disabled. This uses a crossfade between frames and displays a
smoother playback when frame rate is lower than original.

8.6 Audio (optional)
Note: Audio is grayed-out if Audio support is not enabled in Configuration mode.

In Audio, control the volume for the selected layer and assign audio channel to output.
Use the Channel mixer to assign an output and volume for each audio channel. Use values from 0.0 to 1.0
for the channel volume.
For example: To play a mono audio media file (1 channel) from two speakers, assign that channel to output
from both output 1 and 2 (O1 and O2) with full volume (1.0).
Note: By default, channel number 1 gets assigned to output 1, channel 2 to output 2 and so on.
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USER MANUAL

8.7 Using Effects

USER MANUAL
In Effect1(Fx1) and Effect2(Fx2), use effects on the media in the layers (keying,
blur, waves, glow, etc.). Two
effects per layer can be used at the same time and both panels are identical.
USER MANUAL
Note: Effect1 is applied on the layer before Effect2. If Fx1 = Pixelize and Fx2 = 3D Cube, the media is pixelized then rotated with cube
effect and vice versa if Fx1 = 3D Cube and Fx2 = Pixelize.

USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL

Fig. 39 - Effects
-

To apply an effect, select one effect in the dropdown list, and adjust the effect-specific
parameters to see the result.
Click the Reset button to reset the current effect panel and cancel the effect.
Click the R. params button to reset the parameters and keep the effect selected.

The following table describes the various effects:
Effect

3D Cube

3D Plane
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Image

Description

Reshape the layer into a cube shaped object.
Adjust rotation speed and axes.

Reshape the layer into a 3D plane. Adjust
rotation speed and axes.

USER MANUAL
Effect

Image

USER MANUAL
Description
USER MANUAL
USER MANUAL

3D Sphere

Reshape the layer into a 3D sphere. Adjust
USER MANUAL
rotation speed and axes.
USER MANUAL

Alpha Fill

Alpha Key

USER MANUAL
Uses this layer as the Fill Layer for alpha
USER the
MANUAL
keying when using
Alpha Key effect (see
Alpha Fill and Alpha Key – Cut & Fill page 60).
Uses this layer as the Alpha Key layer for the
previous layer (see Alpha Fill and Alpha Key –
Cut & Fill page 60).

Blur

Add blur to the layer by comparing
surrounding pixels, making outlines less
distinct.

Cartoon

Simplify the colors and smooths the shading
in the layer, increasing the difference
between low and high contrast areas.

Chromakey

Create a color key compositing function.
Adjust Red, Green and Blue value parameters
to set transparency.
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USER MANUAL
Effect

Image

USER MANUAL
Description
USER MANUAL
USER MANUAL

Chromakey inverse

Create a color key compositing function with
USER MANUAL
inverse values to the Chromakey effect.
USER MANUAL
USER MANUAL
USER MANUAL

Comic

Reduce the number of colors and hues used
in the layer, creating a comic book-like effect.

Directional blur

Smear the pixels of the layer into a given
direction.

Drop shadow

Create a background shadow to the layer,
giving the impression that the layer is
situated above the layer behind it.

Edge blur
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Blur the outer borders of the layer.

USER MANUAL
Effect

Image

USER MANUAL
Description
USER MANUAL

Edge Laplace

USER MANUAL
Detect edges in the layer by adding blur and
USER MANUAL
subtract the result
from the original layer
image gradually using the mixing parameter.
USER MANUAL
USER MANUAL
USER MANUAL

Edge Laplace add

Detect edges in the layer by adding blur and
subtracts the result from the original layer
image.

Gaussian blur

Add blur to the layer using the Gaussian
function. The result is a very smooth blur, as
if looking through a translucent glass.

Glow

Make bright areas in the layer appear
brighter, adding the impression of glow.

Halftone

Modify the layer from continuous colors to
single-colored dots. Adjust dots size.
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USER MANUAL
Effect

Image

USER MANUAL
Description
USER MANUAL

Halftone advanced

USER MANUAL
Modify the layer from continuous colors to
MANUAL
single-coloredUSER
dots.
Adjust dots size,
background color and alpha channel.
USER MANUAL
USER MANUAL
USER MANUAL

Heavy blur

Inverse

Add a large amount of blur by comparing
surrounding pixels with a large radius.

Invert the color values of the layer.

Kaleidoscope

Create uniform hyperbolic tiling on the layer,
resembling the view through a kaleidoscope.

Keystone

Modify the layer using the keystone corner
points.
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USER MANUAL
Effect

Image

USER MANUAL
Description
USER MANUAL

Lumakey

USER MANUAL
Create a luminance key compositing function
USER
MANUAL
for the layer,
making
the bright areas
transparent.
USER MANUAL
USER MANUAL
USER MANUAL

Lumakey inverse

Create a luminance key compositing function
with inverse values to the Lumakey effect.

Mask

Mask out or crop the layer so only part of it is
displayed.

Pencil sketch

Color the outlines black and the background
white, creating the impression of a pencil
sketch.

Pixelize

Blur the layer by substantially reducing its
apparent resolution.
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USER MANUAL
Effect

Image

USER MANUAL
Description
USER MANUAL

Quick border

USER MANUAL
Blur and color the outer border of the layer.
Similar to theUSER
EdgeMANUAL
blur effect with more
parameters.
USER MANUAL
USER MANUAL
USER MANUAL

Radial blur

Blur the layer by smearing pixels around the
center point.

Radial blur
advanced

Blur the layer by smearing pixels around the
center point and adjust the position of the
center point.

Sepia

Recolor the layer with a reddish-brown sepia
color.

Sharpen

Increase the contrast where color changes
occur, resulting in a sharper layer image.
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USER MANUAL
Effect

USER MANUAL
Description

Image

USER MANUAL
USER MANUAL
USER MANUAL
Create scaled-down,
tiled copies of the layer.

Tiles

USER MANUAL
USER MANUAL
USER MANUAL
Add a distortion on the layer resembling a
ripple on water.

Water ripple

Add distortion to the layer to create the
impression of waves.

Wave

Table 6 - Effects descriptions

8.7.1 Alpha Fill and Alpha Key – Cut & Fill
Create a Cut & Fill effect using Alpha keying to limit the way the fill layer is displayed.
Note: The lower layer is always the Alpha Fill layer and the upper layer is always the Alpha Key layer.

Tip: To use Cut & Fill, prepare medias to be the “Cut media”. Cut medias are preferably black and white with the black
area being the “displayed” part.

1. Select a Layer in the Layer list.
2. In the Media panel, select a media and play it.
3. In the Effect 1(Fx1) panel, select the Alpha Fill effect in the dropdown list.
This layer is now the Alpha Fill layer.
4. Select the next layer in the Layer list.
5. In the Media panel, select the “Cut media” and play it.
6. In the Effect 1(Fx1) panel, select the Alpha Key effect in the dropdown list.
This layer is now the Alpha Key layer.
The content of the Alpha Fill layer is now displayed in the black areas of the Alpha Key layer.
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USER MANUAL
Note: - Alpha Fill is only effective if the next layer has the Alpha Key effect.

USER MANUAL

- Alpha Key is only effective if the previous layer has the Alpha Fill effect.

USER
MANUALor color correction are not
- The Alpha Key layer only contain the contents from actual media or input. Other effects,
composition
applied.

USER MANUAL
Tip: Use the Alpha Fill Inverse effect on the Alpha Fill layer to display the its content in the white areas instead of the black
ones.

USER MANUAL

8.8 Layer macro

USER MANUAL

Tip: Go to Edit > Options > Layer > Layer Macros to define the number of available
macros
(save slots).
USER
MANUAL

Use Macro to save and load the state of one layer.
USER MANUAL

8.8.1 Create a layer macro
1. Select a layer in the Layer list to save as a macro.
2. Right-click a macro slot and select the layer parameters to save.
3. Click Save.
The layer macro is saved with the selected parameters.
Tip: Name the macro for a clear configuration. Right-click the macro and click Rename to label the macro. Use only
alphanumeric characters.

8.8.2 Load a layer macro
1. Select one or more layers in the Layer list.
2. Click a macro slot.
The macro is loaded on the selected layers.
Tip: Right-click a saved macro and click Reset to empty the macro.

8.9 Geometry
Use Geometry to use Warp, Keystone and Edge Blending features at layer level.
For more information, see Edge Blending page 44.

8.10 Set default show on server boot – Export show
Use Export to set the current show as a default show. This show will be loaded every time the Picturall Series
Media Server is turned on. When starting with exported show, Playback 1 automatically starts playing
assigned cue stack if any is assigned.
-

Click Server then Export to save the current show as a default show.

Exporting erases the previous export. The last exported show is loaded automatically at startup.
Note: The active values on the Layers tab are also exported at the time of the export, they will be the media state where the first cue starts
playing.
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USER MANUAL
9 Program a Show - CueUSER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
Fig. 40 - Cues panel
In the Cue menu, create presets of Layers (with their parameters) and order them with timing settings. A cue
holds visual and non-visual information about the state of one or more layers. A cue is a preset with layers
settings to create a specific view on the displays. For example, cues can change layer position or change a
playback state. Cues are organized in Cue Stacks.

9.1 Presentation
9.1.1 How cues work
By default, the Recording button in the Cue tab is enabled and any modification in the Layers tab is marked
in Green, which indicates that it is recorded in the programmer. The programmer records the last assigned
value for a parameter (not always the default parameter value). It is possible to record unchanged or default
values into a programmer manually. When the desired parameters are recorded in the programmer the
programmer content can be saved to a new cue or added to an existing cue.
When running a cue the change in the server state depends on difference between the output from the
previous cue and the current cue. A parameter only changes if it is defined in the cue.
Cue

Parameter 1

Parameter 2

Parameter 3

Call Cue 1
Call Cue 2

10
20

20
no change (keep 20)

30
35

Call Cue 3

no change (keep 20)

25

40

Call Cue 2

20

no change (keep 25)

35

Table 7 - Cue logic example
In the example above, parameter 2 remains at value 20 when cue 3 is played after cue 2, because no change
is recorded for it. And parameter 2 remains at value 25 when cue 2 is played after cue 3.

9.1.2 Timings (Wait, Fade and Hold)
A cue is associated with timing settings: Wait, Fade and Hold.
-

Wait – Time before executing the content
Fade – Time of the execution of the content
Hold – Time before the next Cue (for Automatic trigger)
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USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
Fig. 41 - Cue timing example
The previous example shows two cues: Cue 1 and Cue 2.
-

USER MANUAL
USER MANUAL

Cue 1 has an intensity value of 100.
Cue 2 has an intensity value of 0.
The intensity starts at 0 and progressively increases to 100 at the fade of Cue 1.
After the end of Cue 1, Cue 2 starts.
The intensity progressively decreases to 0 at the fade of Cue 2.

It is possible to set Default Cue timings for all parameters and custom wait and fade times for specific
parameters. In case of conflict, the custom timings prevail. Otherwise a cue is complete when the cue hold
time is finished.
Note: Cues can run for a longer time than the timing values indicated in the Cues panels.

Fig. 42 - Timing parameters for layers 2, 3 and 4 override default cue timings
Fade exceptions
The following parameters do not fade but will take the new value at start of fade:
-

Media selection / FX selection
Deinterlacing type
Draw mode / Play mode
Scaling algorithm
Timecode settings
Layer synchronization
Media end action
Frame blending
FPS mode
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USER MANUAL
9.1.3 Trigger

USER MANUAL

MANUAL
A trigger is the transition from one cue to the next inside a cue stack. TheseUSER
are the
different types of triggers:
-

Manual: The user must click the Go button to trigger the next cue.
USER MANUAL
Automatic: The next cue is triggered after the previous cue has been completed (wait + fade +
hold).
USER MANUAL
End of media: The next cue is triggered at the end of one media playback. This can be set for a
specific layer or for any layer.
USER MANUAL

9.2 Creating Cues
9.2.1 Create the first Cue

USER MANUAL
USER MANUAL

1. Make sure the Layers menu, Cue menu and cue panels are opened.
2. On the Layers menu, click Reset all to have default settings in all the layer controls.
3. On the Cues panel, click the S-add button to create a new Cue stack. The new stack is activated, new
Cues are automatically added to this Cue stack.
4. Click the Clr button to clear the Programmer.
5. Set desired parameters on the layer controls. Values turn green to indicate the change has been
recorded to the Programmer.
6. Hold Alt and click a parameter to manually select or deselect it from the Recorded selection.
7. Click Save new to save the Cue. The new cue item appears in the Cue list and the Programmer gets
cleared.
Saving a cue empties the Programmer and makes it ready for the next one.
Tips:
- Name the cues to have a clear list using right-click then Rename.
- Check the parameters recorded in the Programmer before saving a Cue.
- Clear the Programmer before creating a Cue.

9.2.2 Edit a Cue
All the created cues are available in the Cue List. To edit a cue:
-

Select a cue in the Cue list, Cue stack or Playback.
Click Edit. The Cue content is copied to the Programmer.
Make adjustments on the layer controls. Values turn green to indicate the change has been
recorded to the Programmer.
Click Save.

Tips: - Right-click a cue and select Run to test it.
- Click the Recording... button to disable / enable recording on layer controls.
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USER MANUAL
9.3 Cue Stacks

USER MANUAL

A cue stack is a sequence that runs the cues in ascending order. Create asUSER
manyMANUAL
stacks as needed.
For example, a media show in a music concert might have a cue stack for each song.
USER MANUAL

9.3.1 Create a cue stack
1.
2.
3.
4.
5.

USER MANUAL
Click S-add to create a cue stack.
Create cues or select cues in the Cue List and drag and drop themUSER
in theMANUAL
stack.
Order the cues inside the stack.
USER MANUAL
Create cue stacks as needed for the show.
Each cue in a cue stack is a reference to the original cue in the Cue list. This reference is called Cue
USER MANUAL
Stack Entry or CSE).

9.3.2 Remove a cue from a cue stack
Right-click a cue in a stack and select Remove to remove it from the stack. This only removes it from the cue
stack and does not delete the cue. The CSE is removed but the cue is still present in the Cue List.

9.3.3 Change trigger type
Right-click a cue in the stack to change trigger type. Choose between Manual and Automatic depending on
whether to trigger the cue manually or want it to run automatically after the previous cue. This can be done
either in the Cue Stack List or in the Playback list.

9.3.4 Order cues in the stack – Index number
Order cues in the stack by using drag and drop or custom index number.
-

Drag and drop a cue in a stack to change its position in the sequence.

Index number
Each Cue Stack Entry (CSE) has a Major index number and a Minor index number. CSEs are ordered by Major
index number in ascending order. The Minor index number is used in case of equal Major index number.
-

Right-click a cue in a stack and select Move, then enter the index numbers.

For example, to move a cue between cues numbered 5.0 and 6.0, enter a major index number 5 and a minor
index number 1.
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USER MANUAL
9.4 Timing and Running Cues in Playback

USER MANUAL

USER
MANUAL
Picturall Series Media Servers can run up to eight cue stacks simultaneously
using
the eight different playback
areas in the cue system. Separate playbacks are useful for example to play different sequences of media on
USER MANUAL
different displays.
To run a cue stack in playback:
USER MANUAL
1. Click

to open Playback 1.

USER MANUAL
2. Drag a cue stack to Playback 1. One playback can only play one stack at a time.
3. Click Go at the bottom of the Playback area to run the playback. USER
SelectMANUAL
a cue and click Go to to skip
to a specific cue.
4. Enter timings for the cues in the Wait, Fade and Hold columns. USER MANUAL
5. Click Rls to release the cue stack from the playback. This only removes the cues from playback, not
from the cue stack list or the cue list.
Note: If a show is exported with cue stacks in one of the Playback areas, rebooting the server will automatically start playing the cues in
the stack.

9.5 Cue tracking
By default, jumping to a cue in the same stack skips all other cues and only applies the parameters of the
target cue. Cue tracking allows jumping to a cue while applying parameters of all cues between the current
cue and the target cue. Cue tracking can be enabled on any playback.
- Check the Track box in a Playback to enable cue tracking.

Fig. 43 - Enable cue tracking
For example, here is a stack with 4 cues:
- The first cue has 3 parameters saved:
x position, y position and scaling.
- The second cue changes the y position.
- Third cue changes the scale.
- And the fourth cue changes the x position.
Fig. 44 - Example of a cue stack
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USER MANUAL
Here is a representation of these cues in sequence (the result is the sameUSER
with or
without tracking enabled):
MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
Fig. 45 - Cue stack example played in sequence
USER MANUAL

9.5.1 Example without cue tracking

USER MANUAL

Without cue tracking, jumping from Cue 1 to Cue 4 only executes Cue 4 and
ignores
Cues 2 and 3.
USER
MANUAL
The only parameter that changes is the x position.

Fig. 46 - Jump from Cue 1 to Cue 4 without cue tracking

9.5.2 Example with cue tracking enabled
With cue tracking enabled, when jumping from Cue 1 to Cue 4 the server checks all the changes in between
Cue 1 and Cue 4. In this case, the succession of parameters of Cue 2, Cue 3, and Cue 4 are added to the result.
The playback jumps to Cue 4 as if all cues were run in a sequence.

Fig. 47 - Jump from Cue 1 to Cue 4 with cue tracking
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USER MANUAL
USER MANUAL

9.5.3 Forward tracking

By default, the server only checks the changes between the current cue USER
of theMANUAL
playback and the target cue
of the jump. This default tracking is called forward tracking.
USER MANUAL
Let’s take another example with the same cue stack:
1. Load Cue 1.
2. Manually rotate the layer.
3. Jump to Cue 4 with cue tracking.

USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL

Fig. 48 - Forward tracking example
In this example, the rotation is kept and the jump from Cue 1 to Cue 4 adds all changes between the cues
(new y position + new scale + new x position).

9.5.4 Full tracking
With full tracking, the server resets the show to the beginning of the playback and jumps to the target cue
while applying all changes from the first cue to the target cue of the jump. Full tracking ignores and removes
all manual changes that happened during the playback.
To perform a full tracking jump, hold the Shift key and click the Go or Go To buttons.
Same example with full tracking:
1. Load Cue 1.
2. Manually rotate the layer.
3. Jump to Cue 4 with full cue tracking.

Fig. 49 - Full tracking example
In this example, the rotation is reset as the jump from Cue 1 to Cue 4 resets the show before adding all cues
up to Cue 4.
Note: When jumping backwards in a cue stack (for example from Cue 4 to Cue 2), the server always performs full tracking.

Tip: Use hotkeys Shift + F9 to 12 for Playback 1 to 4 to performs a Go with forward tracking.
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9.6 Example Show

USER MANUAL

USER MANUAL
Let us create a simple show in which one media layer is playing in the background
and another layer is on top
of it with a logo (still image) on it. Using cues, the logo will move from the left side of the projection area to
USER MANUAL
the right side.
To achieve this, do the following:
USER MANUAL
1. Open the Cues panel and make sure Recording… is enabled.
2. Click the Clr button to clear the Programmer
USER MANUAL
3. Go to Layers, select a background media and play it on Layer 1 (a green border appears around these
USER MANUAL
controls).
4. In Cues, click Save new to create a cue with the recorded media state. A new cue appears in the Cue
USER MANUAL
list.
5. In Layers, select the logo image in the Media selection panel of Layer 2, play it and use the position
controls to place it on the left side of the composition.
6. Make sure that media selection, play mode and position control adjustments are recorded on the
Programmer.
7. In Cues, click Save new to create a new cue.
8. In Layer 2, use the position controls to move the logo to the right side of the composition.
9. In Cues, click Save new to save the position change to a new cue.
Three cues are created in the Cue List: a background media without logo, the background media with the
logo on the left and the background media with the logo on the right.
10. Click S-add to create a new cue stack in the Cue stack list. Select the cues and drag them into this
stack.
11. Drag the stack into Playback 1.
12. Select the first cue in the Playback list and click Go.
o Enter timings for each cue (Wait, Fade and Hold).
o Right-click a cue to change its trigger type (Manual or Automatic).
o In Manual mode, keep clicking Go to go through the three cues of the Playback.

9.7 Live show recommendations
Here a few tips and recommendations for live show setup:
-

-

Create a cue with all layers stopped and zero intensity then put it at the beginning of the main
showcue stack. This way the programming starts from blackout and there are no surprises when
jumping back to start of the show.
Use separate playbacks to play different sequences of media on different displays.
Set the User Interface so that the Cues, Layers, and Performance panels are visible.
When live, use the Layers panel only for adjusting minor things such as audio volume.
Hide the Displays, GPU and other tabs that do not directly affect the show.
Set hotkeys on the keyboard to play specific Playbacks (Edit > Options > Keymap), by default F9,
F10 and F11 play Playback 1, 2 and 3 respectively.
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9.8 Cue macro

USER MANUAL

A cue macro is an action associated to a Cue or a Cue stack.

USER MANUAL

Note: - Cue macro and Layer macro are different concepts.

USER MANUAL

- A saved show (.pcf file) containing Cue macros can only be loaded on Picturall Commander from version 2.6 and onwards.

9.8.1 Cue macro and Cue stack macro
9.8.1.1 Cue macro
A cue macro is associated to a cue and affects all CSEs of this cue.
-

The cue macro is executed when the cue is executed.

USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL

To create a cue macro:
-

Right-click a cue in the Cue List (or a CSE in a Cue stack) then click Edit macro…

9.8.1.2 Empty cue
It is possible to create a cue macro on an empty cue (a cue with no layer change).
To create an empty cue:
-

Right-click a cue in the Cue List then click Add cue.

Note: It is also possible to delete the parameters of an existing cue to make it empty.

9.8.1.3 Cue stack macro
A Cue stack can have two types of macro associated to it: entry macro and exit macro.
-

The entry macro is executed when the Cue stack is loaded in a playback.
The exit macro is executed when the Cue stack is released from a playback.

To create a Cue stack macro:
-

Right-click a Cue stack in the Cue Stack List then click Edit entry macro… or Edit exit macro…
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9.8.2 Cue macro actions

USER MANUAL

USERthat
MANUAL
Tip: A little “M” appears next to the Cue number (or Cue stack number) to indicate
a Cue macro is enabled.
When creating a Cue macro, the following window opens and four macro actions are available:
USER MANUAL
- Trigger a specific cue
- Trigger a specific playback
USER MANUAL
- Send a network command
USER MANUAL
- Custom macro
USER MANUAL
USER MANUAL

Fig. 50 - Cue macro

9.8.2.1 Trigger cue macro
This executes a cue when a macro is executed.
1. Click Trigger cue.
2. Click the dropdown list and select a cue.
3. Click OK.

9.8.2.2 Trigger playback
This executes a playback when a macro is executed.
1. Click Trigger playback.
2. Click the dropdown list and select a playback number.
3. Click OK.

9.8.2.3 Trigger network command
This sends a custom command to a device connected on the same network when a macro is executed.
1.
2.
3.
4.
5.

Click Trigger network command.
Enter the target address and port number.
Enter the command to be sent.
Choose the Line separator.
Click OK.
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9.8.2.4 Macro content and Custom macro command

USER MANUAL

USER MANUAL
When creating a cue macro, the content of the macro is displayed in the Macro
content section.
USER MANUAL
USER MANUAL
USER MANUAL
Fig. 51 - Macro content
USER MANUAL
Cue macros are written in Lua language. Using a custom macro, it is possible to write anything in Lua in the
content section. For example, a custom macro can be used to trigger multiple
and playbacks and send
USER cues
MANUAL
a network command at the same time.
Tip: - Click an action to load a command then click custom macro to edit the content.
- The command list is available in a document enclosed to this User Manual.

To create a custom cue macro:
1.
2.
3.
4.

If needed, click any action to load the content.
Click Custom macro.
Edit the content to create a custom command.
Click OK.

Note: Custom macro does not have syntax validation. Enter custom commands carefully.

9.8.3 Edit or remove a cue macro
To edit a cue macro:
1. Right-click a Cue or a Cue stack then click Edit macro…
2. Edit the cue macro then click OK.
To remove a cue macro:
1. Right-click a Cue or a Cue stack then click Edit macro…
2. Click Remove macro.

9.8.4 Create cue macros using Lua commands
For more information, see the document Cue_Macro_Lua_API.pdf attached to this manual.
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1 0 Miscellaneous

USER MANUAL
USER MANUAL

10.1 Save a show

USER MANUAL
Save a show to recover it or to reuse it on another computer using Picturall Commander.
USER MANUAL
1. Run Picturall Commander.
2. Go to File > Save show.
3. Select a folder and enter a filename.
4. Click Save.

USER MANUAL
USER MANUAL

The show is saved in a PSF file.
-

USER MANUAL

Go to File > Load show to load a show.

10.2 Sync card – Genlock (Picturall Pro only)
The sync card is an optional card for Picturall Pro to enable Genlock.
Note: - Genlock is automatically enabled if the sync card is installed.
- The Frame Lock connectors are currently not supported.
- Genlock is possible for the following refresh rates: 50Hz, 60Hz,100Hz, 120Hz and 200Hz.

10.2.1 Genlock menu
In the Genlock menu, check the sync status.
- If needed, click Resync genlock to reset synchronization.
- If needed, use Framelock pulse delay to adjust the sync manually using an offset in nanoseconds.

10.2.2 House sync status LED
When the Genlock is correctly connected, the LED under the connector lights up (labeled House sync).

Fig. 52 - Genlock connection status LED

10.2.3 GPU sync status
The “SYNC” LEDs indicate the sync status per GPU.
The following image shows which LED corresponds to which GPU.
LED off
Yellow LED on
Yellow LED blinking
Green LED blinking
Green LED on
Fig. 53 - LED-GPU correspondence
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SYNC LED status
GPU is not connected
GPU is not synchronized
GPU is synchronized but nearly losing sync
GPU is synchronizing
GPU is synchronized
Table 8 - GPU sync status

USER MANUAL
USER MANUAL

10.3 Performance

USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL

Fig. 54 - Performance menu
In the Performance menu, monitor the performance of the system as graphs.
Use the Enabled checkboxes to show/hide the corresponding graphs.
Tip: These metrics are useful to show potential problems.

Graph

Description

Average workload.
“1” means the load is equivalent to a single CPU core being fully loaded.
“8” means that 8 cores are fully loaded.
CPU
If the value is higher than number of CPU cores installed, the CPUs is doing more than it can
handle. However, this value does not reflect the smoothness of the playback. The average
workload can get high without affecting playback quality.
CPU_TEMP CPU temperature in Celsius degrees.
GPU refresh rate. The server unit’s performance is fine if the indicator values match the
GPU
display’s refresh rate. In this example the display refresh rate is 60.
Time it takes GPU to draw one single frame. If GPU_DRAW reaches 80% of GPU_SWAP,
GPU_DRAW
lower GPU load (effects, resolutions, active layers).
GPU_MEM The amount of memory used by the GPU.

GPU_TEMP

Time it takes GPU to show one frame (except when Triple buffering is enabled). This should
always be 16.67 ms for 60Hz displays.
GPU temperature in Celsius degrees.

GPU_TEX

The amount of data transferred to the GPU (in megabytes per second).

GPU_SWAP

Table 9 - Performance

74
www.analogway.com

USER MANUAL
10.3.1 Toggle view
On the top left of the Performance tab toolbar are the view buttons:

USER MANUAL
USER MANUAL
USER MANUAL

Toggle between graph and table view, or both of them side by side horizontally or vertically.
USER MANUAL

10.3.2 Refresh

USER MANUAL
On the top right corner, set refresh rate, turn refreshing on/off and manually refresh the graphs.
USER MANUAL

10.3.3 Color
USER MANUAL
In the Color column in the table, click the […] buttons on every row to set the color scheme of the graph view.

10.4 Timecode
In the Timecode menu, set the timecode format and offset it by time or frames.

The Timecode format and Timecode offset fields show the current values.
1. In Timecode source, click the dropdown and select the layer to output the timecode from. Or select
OFF to disable sending the outgoing timecode.
2. Click Edit and enter new values in the MTC Settings dialog.

75
www.analogway.com

USER MANUAL
10.5 Control Model

USER MANUAL

MANUAL
The Control Model is a tree structure of all the control groups and the USER
controls
in them. It is mostly used
when programming custom control systems.
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL

1. Open both the Control Model and Properties tab.
2. Click in the tree structure to view control-specific information and view the information on the
Properties tab.

10.6 Commander Log
Every action taken in Picturall Commander is logged.
-

Go to View > Commander Log… to open the panel.

Seeing the command format is useful for advanced Linux users as Picturall Commander can be controlled via
sent commands.
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1 1 User maintenance and Troubleshooting
USER MANUAL

11.1 User Maintenance – Air filter

USER MANUAL

Tip: For optimal performance, this air filter must be cleaned by the user regularly (once a year).

MANUAL
The Picturall Series Media Server is equipped with a removable air filter atUSER
the front
of the media server.

11.1.1 Air filter cleaning - Picturall Twin, Quad and ProUSER MANUAL
Tools:
1.
2.
3.
4.

Torx T20 screwdriver, duster or vacuum.

USER MANUAL

Turn the media server off and unplug mains.
USER MANUAL
Remove the four screws on the front panel.
Using both hands, gently pull the front panel on a straight axis.
Gently tilt it down until mechanical stop.

The front panel is in safe still position.
5.
6.
7.
8.
9.
10.

Pull the air filter and take it out from the media server.
Carefully clean the air filter with a duster or vacuum.
When the air filter is clean, gently put it back in place.
Gently tilt up the front panel until it is aligned.
Gently push the front panel back in place on a straight axis.
Set the screws back in place.

The air filter is cleaned and the media server is ready for use.

11.1.2 Air filter cleaning - Picturall Twin Compact and Quad Compact
Tools:
1.
2.
3.
4.
5.
6.
7.

Torx T10 screwdriver, duster or vacuum.
Turn the media server off and unplug mains.
Remove the screws of the filter cover on top of the front panel.
Remove the filter cover using the screwdriver to access the air filter.
Gently pull the air filter upwards on a straight axis and take it out from the media server.
Carefully clean the air filter with a duster or vacuum.
When the air filter is clean, gently put it back in place.
Set the filter cover back in place.

The air filter is cleaned and the media server is ready for use.

11.2 System Diagnostics
System diagnostics are used for technical support. It is a file exported from Picturall Commander to be sent
to technical support.
To export the system diagnostics file:
1. Go to File > Get system diagnostics.
2. Save the file on the computer.
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USER MANUAL
11.3 Troubleshooting
Picturall Commander installation failure
-

USER MANUAL
USER MANUAL

Make sure to install the latest version of Picturall CommanderUSER
as it MANUAL
corrects all known issues

Layer control > Advanced: Dropdown menus are not visible

USER MANUAL
Make sure to use the latest version of Picturall Commander as it corrects all known issues
USER MANUAL
Unable to Connect to the Server
-

-

Verify that the server and the computer running PicturallUSER
Commander
MANUALare using the same
netmask.
Verify that the server IP-address is correct.
USER MANUAL
Verify that the network is running correctly with a ping command.
Verify that there is no more than one DHCP server in the network.
Verify that the firewall is not blocking the connection.

Video Playback is not smooth
-

Disable unused displays.
Verify there are no playing back of layers that are not visible: select all layers in the Layer list,
right-click on them and select Stop. Then click Play on the desired layers only.
Too many layers or too high resolutions are in use. Playback performance is 4-16 layers of FullHD
depending on the display setup, codecs and bitrates.
Simultaneous use of displays with different refresh rates. Force resolution and refresh rate in the
Configurator.

Video output has poor resolution
-

Disable unused outputs.
Position displays using the same graphic card closer to each other and optimize the pixel space
in the GPUs tab.

“Cable disconnected” error message keeps displaying
-

Stop all playbacks.

Output not displayed due to cable disconnection or image processor reboot
-

In Picturall Commander, go to GPU menu and click Refresh displays.

Sync error when connecting an external clock while the media server is running (Picturall Pro with Genlock)
-

In Picturall Commander, go to Genlock menu and click Resync genlock.
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USER MANUAL
USER MANUAL

APPENDICES

USER MANUAL

Appendix A. DMX chart

USER MANUAL

PICTURALL V3.0
DMX Chart - Layer full

USER MANUAL
USER MANUAL

LAYER SIZE AND POSITION:
-

Composition canvas has coordinates from 0,0 to 1,1 with 0,0 being the bottom left corner
USER

MANUAL

-

Layer default position is 0.5, 0.5 (32768, 32768 in DMX values).

-

Position coordinate is the layer center point coordinate.

-

Default scale for layer is 1.0 (32768 in DMX values). Default layer width is 1.0 in canvas coordinates.

-

Layer height is affected by media Aspect ratio and Aspect-control. Media default Aspect is used when Aspect is 1.0.

-

Aspect ratio height multiplier derived from media aspect ratio and scale.

-

For Scale and Aspect value, descriptions contain physical value multiplier. For example, “7 x” in Scale means the layer is seven times

USER MANUAL

larger is scaled and “7 x” in Aspect means the media aspect ratio is multiplied by seven.

LAYER:
DMX

DMX
Name

COARSE

Description

Values

FINE

1

Default

Home/

Value

locate value

Values description
0

255

2

3

X

Layer X position

0 – 65535

Coordinate ranges from -5 to 5

32768

32768

4

5

Y

Layer Y position

0 – 65535

Coordinate ranges from -5 to 5

32768

32768

6

7

Rotation

32768

32768

32768

32768

32768

32768

8

10

Intensity

9

11

0 – 65535

Scale

Aspect
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0 – 16383

Continuous rotation counterclockwise, 240 RPM – 0 RPM

16384

Indexing rotation counterclockwise 360'

16385 – 32767

Indexing rotation counterclockwise

32768

Center position

32769 – 49151

Indexing rotation clockwise

49152

Indexing rotation clockwise 360'

49153 – 65535

Continuous rotation clockwise, 0 RPM – 240 RPM

0 – 65535

Vertical Scaling

0

Mirrored and flipped layer max size, -5 x

1 – 21844

Mirrored and flipped layer upscaling, -5 x

21845

Mirrored and flipped layer fullscreen, -1 x

21846 – 27306

Mirrored and flipped layer downscaling -1 x – 0 x

27307 – 32767

Layer downscaling, 0 x – 1 x

32768

Layer fullscreen, 1 x

32769 – 65534

Layer upscaling, 1 x – 7 x

65535

Layer upscaling max size, 7 x

0 – 65535
0

Flipped layer upscaling max size, -5 x

1 – 21844

Flipped layer upscaling, -5 x - -1 x

21845

Flipped layer original aspect ratio, -1 x

21846 – 27306

Flipped layer downscaling, -1 x – 0 x

27307 – 31402

Layer downscaling, 0 x – 0.75 x

USER MANUAL
DMX

Name
COARSE

Description

Values

4:3 -> 16:9 conversion, 0.75 x

31404 – 32767

Layer downscaling, 0.75 x – 1 x

32768

Layer original aspect ratio, 1 x

32769 - 34587

Layer upscaling, 1 x – 1.33333 x

34588

16:9 -> 4:3 conversion, 1.33333 x

34589 - 65534

Layer upscaling, 1.33333 x – 7 xUSER

65335

Layer upscaling max size, 7 x
Check ranges table

0 – 255

13

Media index

0 – 255

14

Media library

0 – 255

15

Media mode

0 – 255

16

FPS

0 – 255

18

Seek

Seek to position

Home/

Value

locate value

USER MANUAL

31403

Draw mode

Default

Values description

FINE

12

17

USER MANUAL

DMX

USER MANUAL
USER MANUAL
MANUAL

USER MANUAL
USER MANUAL

Check ranges table

0

Media default fps

1 – 63

1 – 63 fps fixed playback

64 – 160

0% - 200% relative playback speed

112

Media default fps

161 – 255

Reserved (frame blending)

0 – 65535
0

Beginning of the media

65535

End of the media

0

0

No value

0

No value

0

0

112

112

No value

No value

0

255

19

Audio volume

20

Reserved

Reserved

No value

No value

21

Reserved

Reserved

No value

No value

22

Sync source

Layer sync

0

Internal (no sync)

0

0

source

1 – 128

Sync to layer 1 – 128

(V1.2 and later)

255

Sync to MTC
128

128

128

128

128

128

128

128

128

128

23

24

25

26

27

Saturation

Brightness

Contrast

Gamma

Brightness Red
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0 – 255

0

0 – 255
0 – 127

Less saturation

128

Default

129 – 255

More saturation

0 – 255
0 – 127

Less brightness

128

Default

129 – 255

More brightness

0 – 255
0 – 127

Less contrast

128

Default

129 – 255

More contrast

0 – 255
0 – 127

Low gamma

128

Default

129 – 255

High gamma

0 – 255

USER MANUAL
DMX

Name
COARSE

28

29

30

31

32

USER MANUAL

DMX
Description

Values

FINE

Brightness Green

0 – 127

Reduce Red

128

Default

129 – 255

Increase Red

0 – 255

Brightness Blue

0 – 127

Reduce Green

128

Default

129 – 255

Increase Green

locate value

USER MANUAL

0 – 127

Reduce Blue

128

Default

129 – 255

Increase Blue

0 – 127

Reduce contrast for Red color

128

Default

129 – 255

Increase contrast for Red color

128

128

128

128

128

128

128

128

128

128

USER MANUAL

USER MANUAL

0 – 255

Contrast Blue

Value

USER MANUAL

0 – 255

Contrast Green

Home/

USER MANUAL

USER MANUAL

0 – 255

Contrast Red

Default

Values description

0 – 127

Reduce contrast for Green color

128

Default

129 – 255

Increase contrast for Green color

0 – 255
0 – 127

Reduce contrast for Blue color

128

Default

129 – 255

Increase contrast for Blue color

33

FX1 Library

FX1 Library

0 – 255

Select FX (look at FX Assignment sheet)

0

0

34

FX1 Index

FX1 Index

0 – 255

Select FX

No value

No value

35

FX1 Param1

FX1 Param1

0 – 255

No value

No value

36

FX1 Param2

FX1 Param2

0 – 255

No value

No value

37

FX1 Param3

FX1 Param3

0 – 255

No value

No value

38

FX1 Param4

FX1 Param4

0 – 255

No value

No value

39

FX1 Param5

FX1 Param5

0 – 255

No value

No value

40

FX1 Param6

FX1 Param6

0 – 255

No value

No value

41

FX1 Library

FX1 Library

0 – 255

Select FX

0

0

42

FX1 Index

FX1 Index

0 – 255

Select FX

No value

No value

43

FX1 Param1

FX1 Param1

0 – 255

No value

No value

44

FX1 Param2

FX1 Param2

0 – 255

No value

No value

45

FX1 Param3

FX1 Param3

0 – 255

No value

No value

46

FX1 Param4

FX1 Param4

0 – 255

No value

No value

47

FX1 Param5

FX1 Param5

0 – 255

No value

No value

48

FX1 Param6

FX1 Param6

0 – 255

No value

No value

49

Reserved

Reserved

No value

No value

50

Reserved

Reserved

No value

No value

51

Reserved

Reserved

No value

No value

52

Reserved

Reserved

No value

No value

53

Reserved

Reserved

No value

No value
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USER MANUAL
DMX

USER MANUAL

DMX
Name

COARSE

Description

Values

FINE

54

Reserved

Reserved

55

Reserved

Reserved

56

Reserved

Reserved

Default

Home/

Value

locate value

Values description

USER MANUAL
USER MANUAL

No value

No value

No value

No value

No value

No value

USER MANUAL
RANGES:

USER MANUAL

Parameter
Draw mode

Media mode

Value

Name

Description

Additive

Add layer intensities

1

Replace

Replace lower layer

2

Subtract

Subtract upper layer from lower layers

3

Darken

Select darker parts of upper and lower layers

4

Lighten

Select lighter parts of upper and lower layers

5

Multiply

Multiply layer intensities

6

Linear burn

Linear burn (Subtract variant)

7

Screen

Screen layers (opposite of Multiply)

0

Media default

1

Play Next

Play next media after current

2

Play Stop

Stop after playing current media

3

Play Pause

Pause on the last frame of current media

4

Play Loop

Loop current media

5

Pause

6

Stop

10

Play Loop collection

www.analogway.com

USER MANUAL

Play next media and after last media in collection, replay from the
first one.
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USER MANUAL

0

USER MANUAL
EFFECTS:
FX NAME

USER MANUAL
Library

Index

Parameter 1

Parameter 2

Parameter 3

Wave

1

1

Amplitude

Amplitude aspect

Frequency

Water Ripple

1

2

Size

X

Y

Blur

2

1

Size

Heavy blur

2

2

Blur size

Gaussian blur

2

3

Blur size

Radial Blur

2

4

Size

Amount

Radial Blur Advanced

2

5

Size

Amount

Directional Blur

2

6

Blur size

Angle

Glow

2

7

Threshold

Glow size

Chromakey

3

1

Threshold

Chromakey Inverse

3

2

Lumakey

3

Lumakey Inverse

Parameter 4

Parameter 5

Parameter 6

USER MANUAL
Frequency aspect
Speed
USER MANUAL
USER MANUAL
USER MANUAL

Blur center X

Blur center Y

Red key

Green key

Blue key

Smoothing

Threshold

Red key

Green key

Blue key

Smoothing

3

Accuracy

Key

Smoothing

3

4

Accuracy

Key

Smoothing

Alpha Fill

3

5

Alpha Fill inverse

3

6

Alpha Key

3

7

Quick Border

4

1

Amount of

Outside blur

Inside blur

Border color red

Border color

Border color

green

blue

USER MANUAL
USER MANUAL

border
Edge Blur

4

2

Blur amount

Mask

4

3

Mask left

Mask right

Mask top

Mask bottom

Keystone

4

4

On/Off

Left side

Right side

Top side

Bottom side

3D Plane

5

1

X Rotation

Y Rotation

Z Rotation

Continuous

FOV

Material mode

3D Cube

5

2

X Rotation

Y Rotation

Z Rotation

FOV

Material mode

FOV

Material mode

rotation speed
Continuous
rotation speed
3D Sphere

5

3

X Rotation

Y Rotation

Z Rotation

Continuous
rotation speed

Sepia

6

1

Inverse

6

2

Amount

Halftone

6

3

Amount

Halftone Advanced

6

4

Amount

Background Red

Background

Background Blue

Green

Background
Transparency

Comic

6

5

Amount

Pixelize

6

6

Amount

Edge Laplace

7

1

Mixing

Edge Laplace Add

7

2

Amount

Sharpening

7

3

Radius

Pencil Sketch

7

4

Amount

Intensity

Cartoon

7

5

Border

Intensity

Tiles

8

1

Scale

Kaleidoscope

8

2

Amount

Shape

Scale

Zoom

Speed

Amplitude

Drop Shadow

9

1

Opacity

X Offset

Y Offset

Color Red

Color Green

Color Blue
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Laplace amount

USER MANUAL
PICTURALL V3.0
DMX Chart - Layer mini

USER MANUAL
USER MANUAL

LAYER SIZE AND POSITION:

USER MANUAL

Ranges are same as in full layer
DMX COARSE

DMX FINE

1

USER MANUAL

NAME
Intensity

USER MANUAL

2

3

X

4

5

Y

6

7

Rotation

8

9

Scale

10

11

Aspect

USER MANUAL
USER MANUAL

12

Draw mode

13

Media index

14

Media library

15

Media mode

16

FPS

17

Audio Volume

18

Reserved

PICTURALL V3.0
DMX Chart - Master
DMX

DMX
Name

COARSE
1

Description

Values

Default

Home/

Value

locate value

Values description

FINE
Grid width

Number of displays in a

0 – 255

Number of columns in a display grid

1

1

0 – 255

Number of rows in a display grid

1

1

0 – 255

Blend the edges of adjacent displays

0

0

0 – 255

Gamma correction on blend area

128

128

0 – 128

Less intense blend gamma (0.00 to 0.45)

128

Default value: 0.45

128 – 255

More intense blend gamma (0.45 to 0.90)

0 – 255

3 predefined values

0

16:9 (default)

1

4:3

2

16:10

3 – 255

16:9 (ignored)

0 – 255

Show test images on display

0

0

0

None (default)

1

Display numbers (DN)

2

DN + Blend areas

3

DN + Display borders

4

DN + Display grid

display grid horizontally
2

Grid height

Number of displays in a
display grid vertically

3

Blend size

4

Blend gamma

Amount of blend overlap in
percentage

5

6

Aspect ratio

Test images
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Blend gamma value

Select display aspect ratio

Test images

USER MANUAL
DMX

Name
COARSE

7

9

Description

Values

8

USER MANUAL

5

DN + Control points

6

DN + Selected display grid

7

DN + Layer borders

8

Layer numbers (disables Display numbers)

9

DN + Blue background

10

DN + Canvas grid

11

DN + Canvas lines all (horizontal, vertical, diagonal)

12

USER
DN + Canvas lines only horizontal

13

DN + Canvas lines only vertical

14

DN + Canvas lines only 45 degrees diagonal

15

DN + Canvas lines only 135 degrees diagonal

16

DN + Canvas lines horizontal and vertical

17

DN + Canvas lines horizontal and 45 degrees diagonal

18

DN + Canvas lines horizontal and 135 degrees diagonal

19

DN + Canvas lines vertical and 45 degrees diagonal

20

DN + Canvas lines vertical and 135 degrees diagonal

21

DN + Canvas lines diagonal of 45 and 135 degrees

22 – 255

None (ignored)

Cue

0

Do nothing

Triggering

1-65535

Trigger cue

Playback 1

0

Do nothing

1-255

Select cue stack & trigger first cue

0

Do nothing

1-255

Select cue stack & trigger first cue

0

Do nothing

1-255

Select cue stack & trigger first cue

0

Do nothing

1-255

Select cue stack & trigger first cue

Playback 2

11

Playback 3

Playback 4
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Default

Home/

Value

locate value

Values description

FINE

10

12

USER MANUAL

DMX

USER MANUAL
USER MANUAL
USER MANUAL
MANUAL

USER MANUAL

USER MANUAL
PICTURALL V3.0
DMX Chart - Display
DMX

USER MANUAL

DMX
Name

COARSE

USER MANUAL
Description

Values

FINE

1

Display position

USER MANUAL

0 – 255
0

Display not affected by setup, keeps previously set values

1 – 254

Display position. Display within grid size is enabled.

3

Keystone TL X

Keystone top

Home/

Value

locate value

0

0

USER MANUAL

Display out of grid is disabled.

2

Default

Values description

USER MANUAL

255

Reset display position and grouping

0 – 65535

MANUAL
Moves coordinate 0 – 0.5 units USER
towards the
center

0

0

0 – 65535

Moves coordinate 0 – 0.5 units towards the center

USER MANUAL

0

0

0 – 65535

Moves coordinate 0 – 0.5 units towards the center

0

0

0 – 65535

Moves coordinate 0 – 0.5 units towards the center

0

0

0 – 65535

Moves coordinate 0 – 0.5 units towards the center

0

0

0 – 65535

Moves coordinate 0 – 0.5 units towards the center

0

0

0 – 65535

Moves coordinate 0 – 0.5 units towards the center

0

0

0 – 65535

Moves coordinate 0 – 0.5 units towards the center

0

0

0 – 65535

Horizontal distortion to compensate tilted viewing angle.

32768

32768

32768

32768

left X
4

5

Keystone TL Y

Keystone top
left Y

6

7

Keystone TR X

Keystone top
right X

8

9

Keystone TR Y

Keystone top
right Y

10

11

Keystone BR X

Keystone
bottom right X

12

13

Keystone BR Y

Keystone
bottom right Y

14

15

Keystone BL X

Keystone
bottom left X

16

17

Keystone BL Y

Keystone
bottom left X

18

19

Angle X

Angle
correction by X

20

21

Angle Y

Angle

Range - 0.0 – 1.0
0

0.0 No distortion (default)

0 – 65535

Vertical distortion to compensate tilted viewing angle.

correction by Y

Range - 0.0 – 1.0
0
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0.0 No distortion (default)

USER MANUAL
Appendix B. BIOS setup
Press the Del button on startup to access BIOS settings.

USER MANUAL
USER MANUAL

Tip: Load default settings and reboot the server before modification (Exit > Load Setup Defaults).

USER MANUAL

Here are the default Pro BIOS settings:
-

Advanced > SATA Configuration > SATA Mode > AHCI Mode USER MANUAL
Advanced > SATA Configuration > S.M.A.R.T Status Check > Disabled
USER MANUAL
Advanced > Onboard devices configuration > Azalia HD Audio > Disabled
Advanced > Onboard devices configuration > Intel LAN1 Controller > Disabled
USER MANUAL
Advanced > Onboard devices configuration > Intel LAN2 PXE OPROM > Enabled
Advanced > Onboard devices configuration > Asmedia USB 3.0
Controller
> Disabled
USER
MANUAL
Advanced > Onboard devices configuration > Marvell Storage OPROM > Disabled
Boot > Boot > Full Screen Logo > Disabled
Boot > Boot > Wait for ’F1’ if error > Disabled
Boot > Boot > Setup mode > Advanced mode
Boot > Hard Drive BBS Priorities > SSD first
Tool > ASUS O.C. Profile > Label "pro_defaults" > Save to Profile "1"
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USER MANUAL
USER MANUAL

Appendix C. Optimize GPU resolution and drawing performance
USER MANUAL
This chapter describes how to optimize the GPUs performance when positioning
displays.

C.a. Definitions
-

-

USER MANUAL

GPU Output board consisting of two outputs.
USER MANUAL
Output Physical DVI output.
Display Destination where the picture will be displayed. For example,
it could be a single display
USER MANUAL
or a projection surface composed of one or several outputs. Usually there is one display for each
USER MANUAL
output.
Canvas Total drawing area. Displays are placed inside a canvas.
USER MANUAL

Note: Using display splitters enables having more than one display for one output.

C.b. Calculated optimization
In the GPUs menu, select a GPU and click Optimize.
The automatic calculation optimizes the graphic card performance with the current display setup.
If the displays are not side-by-side horizontally in the show composition, using the automatic canvas
optimization gives the best results.

C.c. Canvas and coordinates
Canvas is the drawing area defined in coordinate system, it is not a pixel space.
Canvas coordinates are in 0.0 - 1.0 range in both X and Y axis and origin is in left bottom corner. A display is
positioned in the canvas by setting display X and Y position, display width and height and rotation.
Use the display wizard to set display grids easily.

Fig. 55 - 2x1 grip made with Display wizard
Display coordinates are independent of the display resolution and physical aspect ratio. X and Y in display
positioning point to the left bottom corner of the display.
-

X and Y in layers point to center of the layer.
When scale and scale height are 1, the layer fills the entire display.
Layer aspect ratio control adjusts the aspect ratio of content.
Layer scale controls layer width and height while keeping aspect ratio constant.
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USER MANUAL
USER MANUAL

C.d. Calculating pixels

Drawing is done independently on all GPUs and each GPU draws only theUSER
part MANUAL
of the canvas that is needed
by all the displays connected to that GPU. Then GPU draws one rectangular area that covers all the displays.
USER MANUAL
GPU allocates drawing area that has same resolution as all outputs combined. Output resolutions are
USER MANUAL
composed in horizontal grid except for Matrox TH2GO modes 3x1080p @ 50Hz and 3x1366x768 which have
vertical composition.
USER MANUAL
For example, if GPU is configured for 2 x 1280x1024 resolution, then drawing area will have resolution of
2560 x 1024. For TH2Go 3 x 1280x1024 resolution will be 7680x1024 (2
x 3 MANUAL
x 1280 = 7680). For vertical
USER
exceptions 3 x 1366x768 will be 4098x1536 and 3 x 1080p resolution is 5760x2160.
USERhorizontal
MANUAL (or vertical for the
If the displays for GPU are positioned in canvas so that they form similar
exceptions mentioned before) grid, then displays will have true native resolution1.
If displays have gap between them or they have different sizes then scaling will be performed and native
resolution might not be archived.
To know actual pixels representing single display, first calculate the total area covered by GPU. Then for each
display, multiply the display X and Y resolution by portion of the display width/height of the GPU draw area.
With total width (Total_w), total height (Total_h), display size (w and h) and GPU resolution (GPU_w and
GPU_h). Equation for display "real" resolution is:
𝑤
𝑤𝑖𝑑𝑡ℎ ∶ 𝐺𝑃𝑈_𝑤 ×
𝑇𝑜𝑡𝑎𝑙_𝑤
ℎ
ℎ𝑒𝑖𝑔ℎ𝑡 ∶ 𝐺𝑃𝑈_ℎ ×
𝑇𝑜𝑡𝑎𝑙_ℎ
For example, a setup has two displays with resolutions of 1280x1024.
-

Display 1 has position 0.0, 0.36 and size 0.5 x 0.28.
Display 2 has position 0.82, 0.36 and size 0.18 x 0.10.
Total width for GPU drawing those displays will be 1: Display 2 has rightmost point in the canvas
which is position 0.82 + width 0.18 = 1.0.
From this we subtract leftmost point, which is inside display 1 and X position is 0. So total width
is 1.

Total height is computed similarly, in this case display 1 has both upper and lower limits so area height is
same as display 1 height: 0.28.

Fig. 56 - Drawing area example
1

Native resolution requires displays without Keystoning, Edge blending or curved surface correction applied.
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USER MANUAL
-

GPU_w = 2 _ 1280 = 2560
GPU_h = 1024
Total_w = 1
Total_h = 0:28
Display 2 w = 0:18 and h = 0:10.

Then:

USER MANUAL
0.18
𝑤𝑖𝑑𝑡ℎ ∶USER
2560MANUAL
×
= 460
1.00
0.10
ℎ𝑒𝑖𝑔ℎ𝑡 USER
∶ 1024
×
= 365
MANUAL
0.28
USER MANUAL

The GPU draws Display 1 and 2 in the same pixel space (green area).
Display 2 will have only 460 x 365 pixels representing full display area.

USER MANUAL

Situation will be even worse in the following situation:

USER MANUAL
USER MANUAL

Fig. 57 - Another example of bad performance optimization
Total area is huge compared to either display.
Common situation is for the setup display to be "control monitor" showing everything.
Note: If the control monitor is connected to a GPU that has other displays connected, resolution in those display is going to be bad. This
also affects performance.

C.e. Performance
All layer that are even partially inside GPU draw area are drawn in that GPU. Videos playing on those layers
have to be transferred to the GPU by PCIe bus and the layers have to be drawn. This requires lot of resources
from PCIe bandwidth and GPU processing power. This is particularly troublesome in control monitor situation.

C.f. Conclusion
To get optimal performance and resolution for displays:
-

Position displays that are connected to same GPU as close to each other as possible
Avoid setups where many displays show same area of canvas
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USER MANUAL
USER MANUAL

Appendix D. Picturall Pro communication protocol specifications
D.a. Locating Pro on network

USER MANUAL

USER MANUAL
Pro listens to multicast group 224.0.0.180 port 11009. When it receives message
"HELLO", it responds with
a UDP packet containing following data:
USER MANUAL
/** Structure for Pro identification over network.
*

USER MANUAL

* All strings use UTF-8 character encoding and are always null terminated if
* not otherwise specified.

USER MANUAL

*

USER
* If string doesn’t fit into the allocated buffer it will be silently

MANUAL

* truncated, but will remain null terminated.
*
* bc_version is currently 1. If you get larger values, then protocol has been
* changed and you should discard the packet and get updated specifications
* from Picturall.
* */
struct bcast_identity_s {
char magic[16]; // "PICTURALL SERVER" (no null termination)
uint32_t bc_version; // bcast protocol version network byte order
char ip[32]; // null terminated IP-address
char name[32]; // null terminated host name
char version[32]; // null terminated server version string
} __attribute__ ((packed));

Clients can then connect to a given IP address and use the version field for detecting compatible versions.

D.b. Connecting to Pro
Communication with Picturall Pro works through TCP/IP based telnet-like connection to Pro command line.
Client starts communication by connecting to Pros IP address and port 11000. You can then send commands
to Pro.
For example, you can telnet 10.0.0.1 11000 on the command line on a Windows or a Mac computer. This
grants you access to the Pro command line. You can then enter config on the command line. Pro should print
current version number and some internal configuration data.
When you connect to Pro you should immediately send following command:
wait\_startup

This command waits until Pro startup procedure and show loading is completed. If you connect while Pro
startup is still in progress you might get unexpected results or even hanging due to other commands being
sent. If Pro startup is already completed when this command is given, the command will not do anything.

D.b.a. Compatibility with older versions
If you need compatibility with 1.2 series and older Pros you need to send following special hexadecimal
characters: 0xFF 0xFE 0x01 0x0A. They have to be sent immediately after connection has been established
(even before wait_startup command)
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USER MANUAL
USER MANUAL

D.c. Control model

USERObjects
MANUAL
Pro has three layers of control abstractions: objects, controls and parameters.
are independent units
that implement some parts of Pro’s functionality. Objects usually have some user controllable parameters to
USER MANUAL
control functionality. They are grouped into different controls. Controls contain
any number of parameters.
Parameters are basic controllable entities and they can be of different types:
USER MANUAL
- Int 64bit signed integer
- Double floating point value
USER MANUAL
- String UTF-8 string
USER MANUAL
- DoubleArray Array of floats
- Bool True / false value which is actually integer value where 0 is false and any other value is true.
USER MANUAL
One video layer in Pro consists of several objects: Source, Composer and Audio which are named sourcen,
layern and audion where n is the number of the layer. Layer 1 is controlled by objects source1, layer1 and
audio1.
To get description of controls on a given object you can send command ctrl_info object where object is
name of the object. By sending command ctrl_info source1 a similar output is displayed:
cmd_ctrlInfo() at cmdiface.cc:2409: Control info for source1:
Control:object:0:"Object controls"
Parameter:name:String:"Object name":0:source1
Parameter:description:String:"Description of the object":0:
Control:info:0:"Media information"
r
Parameter:play_state:Int:"Play state. Like Media Mode, but this is
read-only and tells the actual playback state.":1:6:0:255
Parameter:timecode:Int:"Timecode of currently playing media
in nanoseconds":1:0:0:9223372036854775807
Parameter:media_length:Int:"Length of current media
in nanoseconds":1:0:0:9223372036854775807
Control:selection:0:"Media selection"
Parameter:slot:Int:"Currently playing media":0:0:0:255
Parameter:collection:Int:"Currently playing media library":0:0:0:255
Control:control:0:"Media control"
Parameter:media_end_action:Int:"Media: Action to take at end of file":0:0:0:10
Parameter:play_state_req:Int:"Media: Requested play mode":0:6:0:6
Parameter:seek:Double:"Seek":2:0:0:1
Control:sync:0:"Layer synchronization"
Parameter:source:Int:"Sync source":0:0:0:255
Control:time:0:"Media timing"
Parameter:fps:Double:"Frame rate control":0:30:1:140
Parameter:relative_fps:Double:"Relative fps":0:1:0.1:2
Parameter:fps_mode:Int:"FPS mode":0:0:0:1
Parameter:effective_fps:Double:"Current effective fps":1:0:0:10000
Parameter:fps_control_allowed:Bool:"":1:1:0:1
Control:frame_blending:0:"Frameblending"
Parameter:mode:Int:"Frameblending mode":0:0:0:1
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USER MANUAL
1st
2nd
3rd
4th
5th
6th
7th
8th

"Parameter" text (always the same)USER MANUAL
Name of the parameter
USER MANUAL
Parameter type
Parameter description
USER MANUAL
undefined
Default value
USER MANUAL
Minimum value (only for numbers)
Maximum value (only for numbers)USER MANUAL

Table 10 -

Fields in parameter descriptions
USER MANUAL
Looking at the above, you can see that there are 7 controls, although many of them are not really useful for
MANUAL
anything but Pro internal functionality. The most interesting ones inUSER
the layer
source are the info,
selection and control controls. They all have parameters that define what you are currently playing
back.
Parameter description contains at least 6 fields separated by ’:’ that are defined in table 7
You can also use command ctrl_status object to see an object’s current parameter values. Both
ctrl_status and ctrl_info commands send their output normally as human readable text, but also
as a message that is easier to parse by computers.

D.d. Parameter descriptions
Because most of the parameters are trivially understood and you can query them using the ctrl_info
command, only the nontrivial parameters are described here.

D.d.a. Media Mode
Media mode parameter in Source / control describes whether the media is paused, stopped or playing. There
are multiple play modes because we need to know what to do when the media is played to the end: should
we loop, stop or continue to next clip.
-1 Error condition
0 Default (play loop)
1 Play next
2 Play stop
3 Play pause
4 Play loop
5 Pause
6 Stop
Table 11 -

Media modes

Media modes. We have multiple play modes where the last word tells us what happens when the media is
played to the end: should it loop, stop or continue to next clip
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USER MANUAL
0
1
2
3
4
5
6
7

Additive
Replace
Subtract
Darken
Lighten
Multiply
Linear burn
Screen

Table 12 -

Draw modes

USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL

D.d.b. Playback information

USER MANUAL
When video is playing on any layer, the source for layer actively updates Source / info control.

D.d.c. Draw modes
Layer draw mode is defined in Composer / draw_mode. Draw modes are described in table 9

D.e. Messages from Pro
Pro has specifically formatted messages that can be used to receive information about different aspects of
the system.
Messages are sent together with any other output in normal Pro connection. Messages are formed as single
lines in following format:
MSG(target, source, type, content)

-

target: ID of message target
source: Object ID of the sender
type: Message type specified as number
content: Content of message depends on message type
13
14
15
20
24
33
38

CTRL_STATUS
CTRL_INFO
ENUM_OBJECTS
OVERFLOW
MODEL_CHANGE_ADD
CMD_SYSTEM_RESULTS
CMD_SYSTEM_LINE_RESULTS
Table 13 -

Control status (result of ctrl_status)
Control info (result of ctrl_info)
Object list (result of enum_objects)
Message queue overflow (value 20)
Model changed: object added (value 24)
system and system_bg command results
system_bg command line output
Message types

D.e.a. Model changed: object added
When new object is added, server sends MODEL_CHANGE_ADD message. Message has 24 as a type.
Message content is the name of the added object.

D.e.b. Message queue overflow
If the client cannot keep up with the network traffic the server generates, the server will send the client a
message with type 20 (message queue overflow). This message has no content. Immediately after sending
this message, the server will disconnect the client to prevent server crash resulting from out-of-memory
condition.
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USER MANUAL
D.e.c. Control status

USER MANUAL

USERcommand
MANUAL ctrl_status or
Control status message is generated either by directly requesting it by running
by changing a parameter in control. For example, if you change layer intensity from lighting console, you
USER MANUAL
should get control status message to all clients connected to Pro.
Find the object that the controls belong to by translating messages source field from number to object name
USER MANUAL
as specified in section D.E
Message contents are strings that lists controls and their current values in
a format
that is compatible with
USER
MANUAL
set command. Many controls can be specified by separating them with string "\n".
USER MANUAL
Example message (linefeeds added for better readability):
USER MANUAL
MSG(100002, 176, 13, object name="source1",description=""\n
info media_file="/picturall/media/33_CederbergWildernessArea.jpg",
play_state=5,timecode=0,media_length=40000000\nselection slot=2,
collection=0\ncontrol media_end_action=0,play_state_req=0,seek=0\n
sync source=0\ntime fps=30,relative_fps=1,fps_mode=0,effective_fps=25,
fps_control_allowed=1\nframe_blending mode=0\n)

D.e.d. Control info
Control info message is like control status except that instead of status this message sends information about
objects parameters.
Message content is the parameter descriptions for object.
Example message (linefeeds added for better readability):
MSG(100002, 176, 14, Control:object:0:"Object controls"\nParameter:name:
String:"Object name":0:source1\n
Parameter:description:String:"Description of the object":0:\nControl:info:0:"
Media information"\nParameter:media_file:String:"Filename of current media":
1:\nParameter:play_state:Int:"Play state.
Like Media Mode, but this is read-only and tells the actual playback state.": 1:6:0:255\n
Parameter:timecode:Int:"Timecode of currently playing media in nanoseconds":
1:0:0:9223372036854775807\nParameter:media_length:Int:"Length of current media in
nanoseconds":1:0:0:9223372036854775807\nControl:selection:0:"Media selection"\n
Parameter:slot:Int:"Currently playing media":0:0:0:255\nParameter:collection:Int:"
Currently playing media library":0:0:0:255\nControl:control:0:"Media control"\nParameter:
media_end_action:Int:"Media: Action to take at end of file":0:0:0:10\nParameter:play_state_req:
Int:"Media: Requested play mode":0:6:0:6\n
Parameter:seek:Double:"Seek":2:0:0:1\nControl:sync:0:"Layer synchronization"
\nParameter:source:Int:"Sync source":0:0:0:255\nControl:time:0:"Media timing"\nParameter:
fps:Double:"Frame rate control":0:30:1:140\n
Parameter:relative_fps:Double:"Relative fps":0:1:0.1:2\nParameter:fps_mode:Int:"FPS mode":
0:0:0:1\nParameter:effective_fps:Double:"Current effective
fps":1:0:0:10000\nParameter:fps_control_allowed:Bool:"":1:1:0:1\nControl:frame_blending:0:"
Frameblending"\nParameter:mode:Int:"Frameblending mode":0:0:0:1\n)
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USER MANUAL
D.e.e. Object list

USER MANUAL

USER
Object list is result of enum_objects. It lists objects and their object ID:s.
It isMANUAL
used to translate object IDs
to object names.
USER MANUAL
Message content is list of all the objects in object_number:object_name
format separated by \n.
USER MANUAL
Example message (linefeeds added for better readability and message is clipped):
MSG(100002, 1, 15, 101:gl_help:\n102:canvas1:\n103:artnet1:\n104:encoder:
USER MANUAL
\n105:mtc:\n140:fx_info:\n175:layer1:\n176:source1:\n180:audio1:\n181:

USER MANUAL
fx_l1_fx1:\n182:fx_l1_fx2:\n183:layer2:\n184:source2:\n188:audio2:\n189:
fx_l2_fx1:\n190:fx_l2_fx2:\n191:layer3:\n192:source3:\n196:audio3:\n197:

USER MANUAL
fx_l3_fx1:\n198:fx_l3_fx2:\n199:layer4:\n200:source4:\n204:audio4:\n205:
fx_l4_fx1:\n206:fx_l4_fx2:\n207:layer5:\n208:source5:\n212:audio5:\n213:
fx_l5_fx1:\n214:fx_l5_fx2:\n215:layer6:\n216:source6:\n220:audio6:\n221:
fx_l6_fx1:\n222:fx_l6_fx2:\n223:layer7:\n224:source7:\n228:audio7:\n229:
fx_l7_fx1:\n230:fx_l7_fx2:\n231:layer8:\n232:source8:\n236:audio8:\n237:
fx_l8_fx1:\n238:fx_l8_fx2:\n239:layer9:\n240:source9:\n244:audio9:\n245:
fx_l9_fx1:\n246:fx_l9_fx2:\n247:layer10:\n248:source10:\n252:audio10:\n
253:fx_l10_fx1:\n254:fx_l10_fx2:\n255:layer11:\n256:source11:\n260:
audio11:\n261:fx_l11_fx1:\n262:fx_l11_fx2:\n263:layer12:\n264:source12:\n
268:audio12:\n269:fx_l12_fx1:\n270:fx_l12_fx2:\n271:layer13:\n
272:source13:\n276:audio13:\n277:fx_l13_fx1:\n278:fx_l13_fx2:\n279:layer14:\n
280:source14:\n284:audio14:\n285:fx_l14_fx1:\n286:fx_l14_fx2:\n287:layer15:\n
288:source15:\n292:audio15:\n293:fx_l15_fx1:\n294:fx_l15_fx2:\n295:layer16:\n
296:source16:\n300:audio16:\n301:fx_l16_fx1:\n302:fx_l16_fx2:\n303:layer17:\n
304:source17:\n308:audio17:\n309:fx_l17_fx1:\n310:fx_l17_fx2:\n311:layer18:\n
312:source18:\n316:audio18:\n317:fx_l18_fx1:\n318:fx_l18_fx2:\n319:citp:\n
320:monitor:\n321:file_watch:\n322:stack1:\n323:stack2:\n324:stack3:\n
325:cue1:\n326:gpu1:\n327:gpu2:\n328:gpu3:\n329:gpu4:\n)

In example above object source1 would have object id of 176.

D.f. Commands
D.f.a. ctrl_status
This command displays current parameter status for given object. If the object is not specified, all parameters
for all objects are displayed. Parameters are sent both as human readable format and as a message.
Examples:
ctrl_status layer30
ctrl_status source1

D.f.b. ctrl_info
This command displays parameter information for a given object. If an object is not specified, all parameters
for all objects are displayed. Parameters are sent both as human readable format and as a message.
Examples:
ctrl_info layer30
ctrl_info source1
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USER MANUAL
D.f.c. enum_objects

USER MANUAL

USER
MANUAL
This command sends a list of objects defined in the Pro show. The list is sent
both
as human readable format
and as a message.
USER MANUAL

D.f.d. loglevel

USER MANUAL
This command allows the client to specify whether debugging log messages and human readable messages
from commands should be sent to this client. This command takes either USER
"all" or
"none" as argument.
MANUAL

D.f.e. receiving

USER MANUAL

This command controls receiving of the system messages. It takes one parameter that is either "all" or "none".
USER MANUAL
receiving all orders Pro to start sending messages to the client giving the command. receiving
none on the other hand stops messages from being transmitted to that client.

D.f.f. set
The ’set’ command sets parameter values in given control / object combination. This command takes three
arguments: First is name of the object to control, the second is control name and the third one specifies
parameters and their values.
Third argument takes the form parameter=value[...] where parameter is name of the parameter
belonging to selected object and value is a valid value for that parameter. Multiple parameter / value pairs
can be given by separating them with comma.
Examples:
set layer14 composition x="0.3",y="0.2",intensity="0.8"
set source1 selection slot=3,collection=2

Set command also allows specifying timing for single set command. When time is specified, the set command
effects are crossfaded to new values in time seconds.
Complete set command format:
set object_name ctrlname [time=<time>] paramname=pvalue[,param2name=p2val[,...]]

For example:
set layer1 composition time=1.5 intensity=0.0
set layer1 composition time=1.5 intensity=1.0,x=1.0

D.f.g. wait_startup
This command blocks all other commands until server startup has been completed. This should be called
immediately after you have connected to Pro to verify that server startup is complete before sending any
commands.

D.f.h. fullscreen
This command allows you to set layer position to match given screen. It is also possible to set layer to cover
list of displays.
Example:
Fullscreen layer1 4 Set layer 1 to fill display 4.
fullscreen layer2 2 5 3 Set layer 2 to fill bounding box formed by displays 2, 3 and 5.
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USER MANUAL
D.g. system and system_bg

USER MANUAL

MANUAL
These commands execute arbitrary command as Linux shell command.USER
Difference
between system and
system_bg is that system blocks while the command is running and then gives all of the command output in
USER MANUAL
one message. system_bg on the other hand runs the command on background
sending one MSG for each
line the command outputs as it is available.
USER MANUAL
These commands send CMD_SYSTEM_RESULTS message once the command is complete and
CMD_SYSTEM_LINE_RESULTS for each output line.
USER MANUAL
CMD_SYSTEM_RESULTS has following fields that can be in any order:
USER MANUAL
- stdout Complete output from standard output
-

stderr Complete output from standard error output
USER
MANUAL
exit_code Command exit code. 0 usually means success and any
other
value some kind of error.
This depends on the command being run.
id Unique id for this system call. Used to identify possibly overlapping output from multiple
system_bg calls.
error Error description in case of bad system call.
success yes/no depending on whether the call succeeded.

None of the fields are mandatory except for success and that either error or exit_code must be given.
All strings have ’"’ and ’ ’ escaped and linefeed replaced with ’n’.
CMD_SYSTEM_LINE_RESULTS has only fields id, stdout and stderr. They behave like in
CMD_SYSTEM_RESULTS. Id field is mandatory.
Both system calls have following structure in sending messages:
-

Send CMD_SYSTEM_LINE_RESULTS to define id
Run the command and send CMD_SYSTEM_LINE_RESULTS for each line the command outputs
Send CMD_SYSTEM_RESULTS when the command completes

Example:
10.0.0.1 # loglevel none
10.0.0.1 # receiving all
10.0.0.1 # system ls /picturall/media/bbb
MSG(100001, 0, 38, id=3)
MSG(100001, 0, 38, id=3, stdout="bbb_sunflower_2160p_60fps_normal.mp4\n")
MSG(100001, 0, 38, id=3, stdout="bbb_sunflower_2160p_60fps_normal.mp4.thumb\n")
MSG(100001, 0, 33, success="yes", id=3, stdout="bbb_sunflower_2160p_60fps_normal.mp4\n
bbb_sunflower_2160p_60fps_normal.mp4.thumb\n", stderr="", exit_code=0)

Line wrapping has been changed in the example to increase readability.
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CONTACT INFORMATIONUSER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL
USER MANUAL

The Americas

Analog Way SAS - Headquarters
Tel.: +33 (0)1 81 89 08 60

Europe, Middle East & Africa

Analog Way Inc.
Tel.: +1 (678) 487 6644
Toll free: +1 855 353 4988

Asia Pacific

Analog Way Ltd
Tel.: +852 2967 0428

2/4 rue Georges Besse
92160 Antony
FRANCE
Sales/General information:

3047 Summer Oak Place
Buford, GA 30518
USA
Sales/General information:

Unit 2705-06, 27/F, Tung Seng
Commercial Building,
69 Jervois Street
Sheung Wan, Hong Kong
Sales/General information:

saleseuro@analogway.com

salesusa@analogway.com

sales-apac@analogway.com

Technical support:

Technical support:

Technical support:

techsupport@analogway.com

techsupportusa@analogway.com

techsupport-apac@analogway.com

Tel.: +33 (0)1 81 89 08 76
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